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Copyright © Tektronix. All rights reserved. 使用許諾ソフトウェア製品は、Tektronix またはその子会社や供給者が
所有するもので、米国著作権法および国際条約の規定によって保護されています。

Tektronix 製品は、登録済および出願中の米国その他の国の特許等により保護されています。 本書の内容は、既に
発行されている他の資料の内容に代わるものです。 また、本製品の仕様および価格は、予告なく変更させていただ
く場合がございますので、予めご了承ください。

TEKTRONIX および TEK は Tektronix, Inc. の登録商標です。

Tektronix 連絡先

Tektronix, Inc.
14150 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA

製品情報、代理店、サービス、およびテクニカル・サポート：
北米内：1-800-833-9200 までお電話ください。
世界の他の地域では、www.tektronix.com にアクセスし、お近くの代理店をお探しください。



保証

当社では、本製品において、出荷の日から 1 年間、材料およびその仕上がりについて欠陥がないことを保証します。
この保証期間中に製品に欠陥があることが判明した場合、当社では、当社の裁量に基づき、部品および作業の費
用を請求せずに当該欠陥製品を修理するか、あるいは当該欠陥製品の交換品を提供します。保証時に当社が使用
する部品、モジュール、および交換する製品は、新しいパフォーマンスに適応するために、新品の場合、または再生
品の場合もあります。交換したすべての部品、モジュール、および製品は当社で保有されます。

本保証に基づきサービスをお受けいただくため、お客様には、本保証期間の満了前に当該欠陥を当社に通知して
いただき、サービス実施のための適切な措置を講じていただきます。お客様には、当該欠陥製品を梱包していただ
き、送料前払いにて当社指定のサービス・センターに送付していただきます。本製品がお客様に返送される場合に
おいて、返送先が当該サービス・センターの設置されている国内の場所であるときは、当社は、返送費用を負担し
ます。しかし、他の場所に返送される製品については、すべての送料、関税、税金その他の費用をお客様に負担し
ていただきます。

本保証は、不適切な使用または不適切もしくは不十分な保守および取り扱いにより生じたいかなる欠陥、故障または
損傷にも適用されません。当社は、以下の事項については、本保証に基づきサービスを提供する義務を負いません。
a）当社担当者以外の者による本製品のインストール、修理またはサービスの試行から生じた損傷に対する修理。b）不
適切な使用または互換性のない機器への接続から生じた損傷に対する修理。c）当社製ではないサプライ用品の使用
により生じた損傷または機能不全に対する修理。d）本製品が改造または他の製品と統合された場合において、改造
または統合の影響により当該本製品のサービスの時間または難度が増加したときの当該本製品に対するサービス。

この保証は、明示的または黙示的な他のあらゆる保証の代わりに、製品に関して当社がお客様に対して提供するも
のです。当社およびベンダは、商品性または特定目的に対する適合性についての一切の黙示保証を否認します。
欠陥製品を修理または交換する当社の責任は、本保証の不履行についてお客様に提供される唯一の排他的な法
的救済となります。間接損害、特別損害、付随的損害または派生損害については、当社およびそのベンダは、損害
の実現性を事前に通知されていたか否に拘わらず、一切の責任を負いません。
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保証

当社では、ソフトウェア製品を提供する目的で使用されているメディア、およびそのメディア上のプログラムのエンコー
ドにおいて、出荷の日から 3 か月間、材料およびその仕上がりについて欠陥がないことを保証します。この保証期
間中にメディアまたはエンコードに欠陥があることが判明した場合、当社では、当該欠陥メディアの交換品を提供し
ます。ソフトウェア製品を提供する目的で使用されているメディアを除き、本ソフトウェア製品は、明示的保証または
暗示的保証を問わず何等保証のない "現状有姿" のまま提供されています。当社では、本ソフトウェア製品に含ま
れる機能がお客様の要求を満たすこと、プログラムの動作が中断されないこと、エラーが発生しないことのいずれも
保証いたしません。

本保証に基づきサービスをお受けいただくため、お客様には、本保証期間の満了前に当該欠陥を当社に通知して
いただきます。お客様から通知を受けた後、妥当な期間内に材料およびその仕上がりに欠陥がない交換品を提供
できない場合、お客様は、本ソフトウェア製品のライセンスを終了して本製品とその関連材料を返却し、お客様が既
に支払った代金を払い戻すことができます。

この保証は、明示的または黙示的な他のあらゆる保証の代わりに、製品に関して当社がお客様に対して提供するも
のです。当社およびベンダは、商品性または特定目的に対する適合性についての一切の黙示保証を否認します。
欠陥メディアの交換またはお客様が支払った代金払い戻しを行う当社の責任は、本保証の不履行についてお客様
に提供される唯一の排他的な法的救済となります。間接損害、特別損害、付随的損害または派生損害については、
当社およびそのベンダは、損害の実現性を事前に通知されていたか否に拘わらず、一切の責任を負いません。
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重要

機器を操作する前にお読みください

本ソフトウェアは、Tektronix, Inc. からのライセンスに基づき提供されます。本プログラムの保有期間が 30 日を超え
た場合、または方法の如何を問わず本プログラムが使用された場合、お客様は、本ライセンス条項を承諾したものと
みなされます。

同梱のソフトウェア・ライセンス契約書をよくお読みください: 本ライセンス条項にご同意頂けない場合、最寄
りのテクトロニクス営業所までお早めにお問い合わせの上、返品に関する手配をご用命ください。

テクトロニクス・ソフトウェア・ライセンス契約書

機器内に搭載されたプログラムも含む本プログラムは、本契約条項を条件として提供されます。本プログラムの保有
期間が 30 日を超えた場合、または方法の如何を問わず本プログラムが使用された場合、お客様は、本契約条項を
承諾したものとみなされます。これらの条項にご同意頂けない場合、未使用のプログラムおよび関連資料をテクトロ
ニクスへ至急ご返送ください。お支払い頂いたライセンス料金を全額払い戻します。（機器に搭載された本プログラ
ムの返却については、最寄りのテクトロニクス営業所までお問い合わせください。）

定義: 「テクトロニクス」とは、機器を供給している米国オレゴン州法人 Tektronix, Inc. または他の国もしくは地域の
テクトロニクス・グループ法人を意味します。

「プログラム」とは、この契約書に該当するテクトロニクスのソフトウェア製品、またはこの契約書を同梱している機器に
含まれているソフトウェア製品（実行可能なプログラムとデータの一方または両方）を意味します。

「お客様」とは、このプログラムを発注した個人または組織を意味します。

ライセンス: お客様は、次の行為を行うことができます。

1. 一時点で 1 台の機器上でのみ本プログラムを使用すること。

2. 本プログラムがフローティング・ユーザ・ライセンスに基づき提供された場合、正規ユーザが複数台の機器上で本
プログラムを使用すること。ただし、一時点での正規ユーザ総数がライセンスに規定の同時使用ユーザ総数を超
えないことを条件とします。

3. 1 台の機器上で使用することを条件として、本プログラムを改変し、または他のプログラムと併合すること。

4. 保管またはバックアップの目的で本プログラムを複製すること。ただし、かかる複製物がどの時点においても 1 部
を超えて存在しないことを条件とします。本プログラムがフローティング・ユーザ・ライセンスに基づき提供された
場合、正規ユーザが使用することを条件として、複数台の機器上に本プログラムをコピーすることができます。

お客様は、自己が作成した本プログラムの各複製物に対し、テクトロニクスから受領した本プログラムと同一の著作
権表示および権利制限事項を明示する必要があります。

お客様は、次の行為を行うことができません。

1. フローティング・ユーザ・ライセンスまたは別途のサイト・ライセンスに基づく場合を除き、同時に複数台の機器上
で本プログラムを使用すること。

2. テクトロニクスから書面による事前の許可を得ることなく、第三者もしくは外部の組織に対し本プログラムを譲渡す
ること、またはお客様が所属している法人に対し本プログラムを譲渡すること。ただし、本プログラムが搭載されて
いる機器を譲渡する場合を除きます。

3. 管轄権を有する米国または他国政府の法令により輸出または再輸出が制限されている国に対し、必要とされる
場合の米国商務省輸出管理局およびかかる他国政府機関の事前の許可なく、本プログラム、関連資料またはこ
れらの直接的産物を直接または間接的に輸出または再輸出すること。



4. オブジェクトコード形式の本プログラムについて、目的の如何を問わず逆コンパイルまたは逆アセンブルを行うこと。

5. 本プログラムの関連資料を複製すること。

1 台の機器に搭載された本プログラムが他の機器に移転されることなく 1 台以上の他の機器をローカルまたはリモー
トで支援する場合、かかる他の機器は、「1 台の機器」の定義に含まれるものとします。本プログラムを複数の機器に
個別に搭載してそれぞれをローカルで稼動させるという運用形態をとる場合、本プログラムを使用する機器ごとに、
またはフローティング・ユーザ・ライセンスに基づく正規の同時使用ユーザごとに別個のライセンスが必要となります。

本プログラムおよびそのすべての複製物（本プログラムまたはかかる複製物が存在するメディアを除きます）に係る
権利は、テクトロニクスに、またはテクトロニクスが各ライセンス権を取得した第三者に帰属します。

お客様は、本プログラムの保有もしくは使用または本ライセンスについて本契約発効以後に課されるすべての税金
を期限までに支払い、かかる税金につき必要とされるすべての届出を行います。

本プログラムのうちお客様により改変された部分、または他のプログラムと併合された部分に対しても、本契約条項
が適用されます。

本プログラムが米国政府機関により、または当該機関のために取得された場合、本プログラムは、私企業の費用負担
にて開発されたコンピュータ・ソフトウェアとみなされ、本契約におけるライセンス許諾は、調達関係の適用法令にて定
義されるとおり、本プログラムおよび関連資料における制限された権利をお客様に許諾することとして解釈されます。

本契約条項により明示的に許可された場合を除き、お客様は本プログラムを使用、複製、改変、併合、または第三
者に譲渡することはできません。

本プログラムの複製物、改変物、または併合部分が譲渡された場合、本契約において許諾されたライセンスは、自
動的にただちに解約されます。

期間: 本契約において許諾されたライセンスは、お客様が本契約を承諾した時点を以て発効し、本契約の規定に
より解約されるまで有効に存続します。お客様は、テクトロニクスに書面にて通知することにより、本ライセンスをいつ
でも解約することができます。お客様が本契約条項に違反した場合において、テクトロニクスまたはテクトロニクスが
各ライセンス権を取得した第三者からその旨の通知があった日から 30 日以内にかかる違反が是正されなかったと
きは、テクトロニクスまたはかかる第三者は、本ライセンスを解約することができます。本契約の解約後、お客様は、
本プログラムおよび関連資料を、形態の如何を問わずその複製物のすべてと共に、ただちにテクトロニクスに返還
し、または破棄します。

制限保証: テクトロニクスは、本プログラムが提供されたメディアおよび本プログラムのメディアへの記録状態に材
質および製造上の欠陥がないことを、発送後 3 ヵ月間保証します。当該保証期間中にかかるメディアまたは記録状
態に欠陥があることが判明した場合、テクトロニクスは、欠陥メディアと交換に代替品を提供します。本プログラムが
提供されたメディアに関する場合を除き、本プログラムは、明示または黙示の何等の保証もなく現状のままで提供さ
れます。テクトロニクスは、本プログラムの機能がお客様の要求を満たすこと、および本プログラムに動作の中断また
は誤動作が全くないことについては保証しません。

本保証に基づくサービスを受けるため、お客様は、当該保証期間の満了前に欠陥をテクトロニクスに通知します。
その後合理的な期間内にテクトロニクスが材質および製造上の欠陥のない代替品を提供することができなかった場
合、お客様は、かかる本プログラムのライセンスを解約することができ、支払済ライセンス料があればその払戻を受け
て本プログラムおよび関連資料を返却することができます。

本保証は、明示であると黙示であるとを問わず、他の一切の保証に代わって、本プログラムにつきテクトロニクスによ
り行われます。テクトロニクスおよびその販売店は、商品性または特定目的に対する適合性についての一切の黙示
保証を否認します。本保証の違反につきお客様に為される救済は、テクトロニクスが欠陥メディアを交換し、または
お支払済ライセンス料があればその払戻を行うことに限定されます。

責任の制限： お客様による本プログラムの保有または使用に起因または関係する間接損害、特別損害、付随的損
害、および派生損害については、テクトロニクスおよびテクトロニクスがライセンス権を取得した第三者は、かかる損
害が発生し得る旨の事前通知を受けていた場合といえども、いかなる責任をも負いません。



第三者の免責事項: 別途明示的に合意した場合を除き、テクトロニクスがライセンス権を取得した第三者は、本プ
ログラムにつきいかなる保証も行わず、本プログラムの使用につきいかなる責任も負わず、また、本プログラムに関す
る支援または情報を提供するいかなる義務をも負いません。

一般条項: 本契約書は、本プログラムの使用、複製、及び譲渡に関する当事者間の完全なる合意事項を構成し
ます。

お客様は、テクトロニクスの事前の書面による同意なく、本契約及び本契約において許諾されたライセンスを第三者
に譲渡することができません。

本契約および本契約において許諾されたライセンスは、米国オレゴン州法令に準拠します。

本契約または本契約において許諾されたライセンスにつきご不明な点がございましたら、最寄りのテクトロニクス営
業所までお問い合わせください。

ビデオ・テスト・シーケンスに対する追加ライセンス供与: ソフトウェア製品には何らかのテスト・パターン、ビデ
オ・テスト・シーケンス、およびビデオ・クリップ（合わせて「ビデオ・テスト・シーケンス」）が含まれている場合がありま
す。その場合、ビデオ・テスト・シーケンスに関するお客様の権利は以下の条項のとおりです。

お客様はビデオ・テストの実行に伴い、ビデオ・テスト・シーケンスの使用、複製、改変、ならびに個々のビデオ・テス
ト・シーケンスの表示もしくは複製の配布を行うことができます。

お客様は、以下のいかなる行為についても許諾されていません。

1. お客様はテクトロニクスからの書面による事前の許可を得ることなく、ビデオ・テスト・シーケンスの集合体につい
て、かかるビデオ・テスト・シーケンスを含む元の機器を売却する場合を除き、配布することはできません。

2. お客様は、ビデオ・テスト・シーケンスの第三者による配布を許可することはできません。

3. お客様は、本ビデオ・テスト・シーケンスの複製を単独で販売、ライセンス供与、もしくは配布してはなりません。ま
たかかるビデオ・テスト・シーケンスが製品やサービスの価値の主体をなす場合は、いかなる集合体、製品、サー
ビスの一部としても販売、ライセンス供与、もしくは配布することはできません。

お客様は、お客様によって改変されたビデオ・テスト・シーケンスの使用もしくは配布の結果生じたいかなる申立ても
しくは訴訟（弁護士費用を含む）に対してもテクトロニクスを免責し、補償し、また弁護しなければなりません。

お客様の製品やサービスにかかるビデオ・テスト・シーケンスの複製を含める場合は有効な著作権表示を含めなけ
ればなりません。
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安全にご使用いただくために

安全にご使用いただくために

人体への損傷を避け、本製品や本製品に接続されている製品への損傷を防止するために、次の安全性に
関する注意をよくお読みください。

安全にご使用いただくために、本製品の指示に従ってください。

資格のあるサービス担当者以外は、保守点検手順を実行しないでください。

本製品をご使用の際に、規模の大きなシステムの他の製品にアクセスしなければならない場合があります。
システムの操作に関する警告や注意事項については、他製品のマニュアルにある安全に関するセクション
をお読みください。

火災や人体への損傷を避けるには

適切な電源コードを使用してください。 本製品用に指定され、使用される国で認定された電源コードの
みを使用してください。

本製品を接地してください。 本製品は、電源コードのグランド線を使用して接地します。 感電を避けるた
め、グランド線をアースに接続する必要があります。 本製品の入出力端子に接続する前に、製品が正しく接
地されていることを確認してください。

すべての端子の定格に従ってください。 火災や感電の危険を避けるために、本製品のすべての定格と
マーキングに従ってください。 本製品に電源を接続する前に、定格の詳細について、製品マニュアルを参
照してください。

本製品の定格は測定カテゴリＩになります。一次回路、設置カテゴリＩＩ，ＩＩＩ，およびＩＶの回路には接続しな
いでください。

共通端子を含むどの端子にも、その端子の最大定格を超える電位をかけないでください。

電源を切断してください。 電源コードの取り外しによって主電源が切り離されます。電源コードをさえぎら
ないでください。このコードは常にアクセス可能であることが必要です。

カバーを外した状態で動作させないでください。 カバーやパネルを外した状態で本製品を動作させな
いでください。

故障の疑いがあるときは動作させないでください。 本製品に故障の疑いがある場合、資格のあるサー
ビス担当者に検査してもらってください。

露出した回路への接触は避けてください。 電源がオンのときに、露出した接続部分やコンポーネントに
触れないでください。

保護メガネを着用してください。 高輝度の光線にさらされる場合やレーザー放射が存在する場合は、保
護メガネを着用してください。

湿気の多いところでは動作させないでください。

爆発性のあるガスがある場所では使用しないでください。

製品の表面を清潔で乾燥した状態に保ってください。

適切に通気してください。 適切な通気が得られるような製品の設置方法の詳細については、マニュアル
の設置方法を参照してください。
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安全にご使用いただくために

本マニュアル内の用語

本マニュアルでは、次の用語を使用します。

警告： 人体や生命に危害をおよぼすおそれのある状態や行為を示します。

注意： 本製品やその他の接続機器に損害を与える状態や行為を示します。

本製品に関する記号と用語

本製品では、次の用語を使用します。

DANGER: ただちに人体や生命に危険をおよぼす可能性があることを示します。

WARNING: 人体や生命に危険をおよぼす可能性があることを示します。

CAUTION: 本製品を含む周辺機器に損傷を与える可能性があることを示します。

本製品では、次の記号を使用します。
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適合性に関する情報

適合性に関する情報

このセクションでは、本器が適合している EMC 基準、安全基準、および環境基準について説明します。

EMC 適合性

EC 適合宣言 - EMC

指令 2004/108/EC 電磁環境両立性に適合します。『Official Journal of the European Communities』に記載
の以下の基準に準拠します。

EN 61326-1:2006: 測定、制御、および実験用途の電子機器を対象とする EMC 基準。 1 2 3

CISPR 11:2003：グループ 1、クラス A、放射および伝導エミッション

IEC 61000-4-2:2001：静電気放電イミュニティ

IEC 61000-4-3:2002：RF 電磁界イミュニティ 4

IEC 61000-4-4:2004：ファスト・トランジェント／バースト・イミュニティ

IEC 61000-4-5:2001：電源サージ・イミュニティ

IEC 61000-4-6:2003：伝導 RF イミュニティ

IEC 61000-4-11:2004：電圧低下と遮断イミュニティ

EN 61000-3-2:2006: AC 電源高調波エミッション

EN 61000-3-3:1995: 電圧の変化、変動、およびフリッカ

欧州域内連絡先:
Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

1 本製品は住居区域以外での使用を目的としたものです。住居区域で使用すると、電磁干渉の原因となることがあります。

2 本製品をテスト対象に接続した状態では、この規格が要求するレベルを超えるエミッションが発生する可能性があります。

3 ここに挙げた各種 EMC 規格に確実に準拠するには、高品質なシールドを持つインタフェース・ケーブルが必要です。

4 MTS4000 型は、オプション QB2 型（QAM Annex B）を除く、すべてのインタフェース・カードの構成で上記整合規格要件
に適合します。本オプションに適用される個別の RF 電磁界イミュニティの条件は次のとおりです。QAM-256 コンスタレー
ション信号を復調する際、QAM Annex B カードは IEC 61000-4-3 の EN 61326-1 表 1 の規定よりも低レベルの放射電磁
界の影響を受けます。これは、同調入力周波数よりも 44 MHz（QAM チューナーの局部発信周波数）高い、非常に狭い
周波数帯域でのみ生じます。このモードにおける QAM 復調器の高感度が原因で、RF ロックが失われたり、ストリーム・エ
ラーが生じることがあります。最高の性能を得るために、ケーブル・アダプタは使用せずに、高品質のシールド・ケーブル
のみを使用して MTS4000 型に接続してください。
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適合性に関する情報

オーストラリア／ニュージーランド適合宣言 -EMC

ACMA に従い、次の規格に準拠することで Radiocommunications Act の EMC 条項に適合しています。

CISPR 11:2003： 放射性および伝導性エミッション、グループ 1、クラス A、EN 61326-1:2006 に準拠

オーストラリア／ニュージーランドの連絡先:

Baker & McKenzie
Level 27, AMP Centre
50 Bridge Street
Sydney NSW 2000, Australia

安全性

EC 適合宣言 - 低電圧指令

『Official Journal of the European Communities』に記載の以下の基準に準拠します。

低電圧指令 2006/95/EC

EN 61010-1:2001：測定、制御および実験用途の電子装置に対する安全基準。

米国の国家認定試験機関のリスト

UL 61010-1:2004 年第 2 版。電子計測器および試験用機器の標準規格

カナダ規格

CAN/CSA-C22.2 No.61010-1:2004：測定、制御、および実験用途の電子装置に対する安全基準、第 1
部

その他の基準に対する適合性

IEC 61010-1:2001：測定、制御、および実験用途の電子装置に対する安全基準

機器の種類

テスト機器および計測機器。

安全クラス

クラス 1 - アース付き製品。
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適合性に関する情報

汚染度

製品内部およびその周辺で発生する可能性がある汚染度の尺度です。通常、製品の内部環境は外部環境
と同じとみなされます。製品は、その製品に指定されている環境でのみ使用してください。

汚染度 1：汚染なし、または乾燥した非導電性の汚染のみが発生します。このカテゴリの製品は、通常、
被包性、密封性のあるものか、クリーン・ルームでの使用を想定したものです。

汚染度 2：通常、乾燥した非導電性の汚染のみが発生します。ただし、結露によって一時的な導電性が
発生することもまれにあります。これは、標準的なオフィスや家庭内の環境に相当します。一時的な結露
は製品非動作時のみ発生します。

汚染度 3：伝導性のある汚染、または通常は乾燥して導電性を持たないが結露時に導電性を帯びる汚
染。これらは、温度、湿度のいずれも管理されていない屋内環境に相当します。日光や雨、風に対する
直接の曝露からは保護されている領域です。

汚染度 4：導電性のある塵、雨、または雪により持続的に導電性が生じている汚染。これは一般的な屋
外環境に相当します。

汚染度

汚染度 2（IEC 61010-1 の定義による）。注：屋内使用のみについての評価です。

測定カテゴリ／過電圧カテゴリの記述

本製品の各端子には異なる測定（過電圧）カテゴリが指定されている場合があります。各測定カテゴリは次
のように定義されています。

測定カテゴリ IV。低電圧電源を使用して実施する測定用。

測定カテゴリ III。建築物の屋内配線で実施する測定用。

測定カテゴリ II。低電圧電源に直接接続した回路で実施する測定用。

測定カテゴリ I。AC 電源に直接接続していない回路で実施する測定用。

過電圧カテゴリ

過電圧カテゴリ II（IEC 61010-1 の定義による）

環境への配慮
このセクションでは本製品が環境におよぼす影響について説明します。

使用済み製品の処理方法

機器またはコンポーネントをリサイクルする際には、次のガイドラインを順守してください。
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適合性に関する情報

機器のリサイクル: 本製品の製造には天然資源が使用されています。この製品には、環境または人体に有害
となる可能性のある物質が含まれているため、製品を廃棄する際には適切に処理する必要があります。有害物
質の放出を防ぎ、天然資源の使用を減らすため、本製品の部材の再利用とリサイクルの徹底にご協力ください。

このマークは、本製品が WEEE（廃棄電気・電子機器）およびバッテリに関する指令 2002/96/EC
および 2006/66/EC に基づき、EU の諸要件に準拠していることを示しています。リサイクル方法
については、当社の Web サイト（www.tektronix.com）のサービス・セクションを参照してください。

水銀に関するお知らせ: 本製品に使用されている LCD バックライト・ランプには、水銀が含まれていま
す。廃棄にあたっては、環境への配慮が必要です。廃棄およびリサイクルに関しては、お住まいの地域の所
轄官庁にお尋ねください。

有害物質に関する規制

この製品は Monitoring and Control（監視および制御）装置に分類され、2002/95/EC RoHS Directive（電気・
電子機器含有特定危険物質使用制限指令）の適用範囲外です。
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このマニュアルでは、当社の MTS4000 型 MPEG テスト・システムの機能と使用方法について説明します。こ
のマニュアルでは、次の規則に従って製品名を表します。

MTS4000 システム：MTS4000 型および MTS4SA 型に該当する情報です。

MTS4SA 型スタンドアロン・システム：MTS4SA 型のみに該当する情報です。

主な特長
MPEG、DVB、ATSC、および ISDB などの広範な DTV 規格をサポート。これらの規格の地上波、ケーブ
ル、衛星、および地域別の放送方式のための特定の SI を含みます。

さまざまなインタフェースと解析機能。RF または IP レイヤ・トランスミッション・リンクやトランスポート・スト
リーム・コンテンツ処理など、あらゆるネットワーク環境で発生する問題を診断するために必要な接続が
実現します。

IP v 4 および IP v 6 の両ネットワークに接続。IGMP および MLD マルチキャスト・プロトコルを使用する
ネットワークも含まれます。

固定ビット・レート（CBR）ストリームの解析。

クロスレイヤ障害解析やログ機能が内蔵されているため、1 つの機器で障害診断を行うことができ、トラ
ブルシューティング時の調査にかかる時間を短縮できます。

再生機能により、パラメトリック機能を伴うスティミュラスが提供され、ネットワークや被測定デバイスの動
作を評価するための IP マルチセッション・レプリケーションが提供されます。

CaptureVu™ テクノロジ。間欠的で複雑な問題をデバッグするために、システム・イベントをリアルタイムお
よび事後に取り込んで解析します。

プログラムを中心とする革新的なユーザ・インタフェース。誰でも専門家の判断を下すことができます。

多重ストリームおよびエレメンタリ・ストリームのコンプライアンスをチェックする H.264 バッファ解析。H.264
コンテンツが含まれるトランスポート・ストリームの作成と解析に使用できる強力なツール群が提供されま
す。

ネットワーク配信と圧縮の結果に起因する問題の切り分けを支援するビデオとオーディオの品質解析。

マルチ入力モニタ。
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マニュアル
このマニュアルでは、MTS4000 システムの設置と基本的な操作方法について説明します。また、この製品
には以下のマニュアルがあります。

項目 内容 参照先

MTS4000 型クイック・スタート・
ユーザ・マニュアル（071-2970-xx
英語、077-0665-xx 簡体字中国
語、077-0666-xx 日本語、077-
0657-xx ロシア語）

テスト・システムの設置方法お
よび使用方法の概要を説明し
ます。

MTS4000 アナライザ・アプリケー
ション・ユーザ・マニュアル（077-
0622-xx）

TSCA、PES Analyzer、T-STD
Buffer Analyzer 、および ES
Analyzer の各アナライザ・アプ
リケーションに関する操作方法
を説明します。

MTS4000 ゼネレータ・アプリケー
ション・ユーザ・マニュアル（077-
0623-xx）

Multiplexer、MPEG Player、TS
Editor、Make Seamless Wiz-
ard 、 Transport Stream Cut-
ter、および Script Pad の各ゼ
ネレータ・アプリケーションに関
する操作方法を説明します。

MTS4000 Carousel アプリケー
ション・ユーザ・マニュアル（077-
0624-xx）

Carousel Analyzer お よ び
Carousel Generator アプリケー
ションの操作について説明し
ます。

MTS4000 型 MPEG テスト・シ
ステム仕様および性能検査に
関するテクニカル・リファレンス
（077-0626-xx）

製品仕様と検査手順について
の一覧を提供します。

MTS4000 型リリース･ノート（077-
0200-xx）

テスト・システムに関する既知
の問題について説明します。

MTS4EA Compressed Video El-
ementary Stream Analyzer ユー
ザ・マニュアル（071-1641-XX）

MTS4EA アプリケーション・ソ
フトウェアの操作方法を説明し
ます。

MTS4CC エレメンタリ・ストリーム・
コンプライアンス・チェッカ・ユー
ザ・マニュアル（071-2075-XX）

MTS4CC アプリケーション・ソ
フトウェアの操作方法を説明し
ます。

PQA600 ピクチャ・クオリティ・ア
ナライザ・クイック・スタート・ユー
ザ・マニュアル（071-2775-xx）

PQA600 アプリケーション・ソフ
トウェアの操作方法を説明しま
す。

VQS1000 ビデオ・クオリティ・ソフ
トウェア・クイック・スタート・ユー
ザ・マニュアル（077-0489-XX）

VQS1000 アプリケーション・ソ
フトウェアの操作方法を説明し
ます。

ユーザ・マニュアルは Tektronix Web サイト（www.tektronix.com/manuals）からダウンロードできます。
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次の URL を使用すると、次の標準機関のホームページにアクセスできます（一覧にある URL はこのマニュ
アルの作成時点で有効な URL です）。

MPEG-2 規格（国際標準化機構）- www.iso.org/

DVB 規格（欧州電気通信標準化機構）– www.etsi.org/

ATSC 規格（高画質テレビ・システム委員会）- www.atsc.org/

このマニュアルで使用される表記規則
このマニュアルでは、次のようなマークが使用されています。

連続したス
テップ

フロント・パ
ネルの電源

電源の接続 ネットワーク PS2 SVGA USB

MTS4000 型および MTS4SA 型クイック・スタート・ユーザ・マニュアル xi
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設置

設置する前に
機器を受け取ったら、次の手順で検査を実行してください。

1. 輸送用段ボール箱に、機器破損の可能性を示す外部損傷がないかどうかを検査します。

2. 輸送用段ボール箱から MTS4000 型機器を取り出します。

3. 輸送中に機器に損傷がなかったかどうかを調べます。機器の外側に傷や衝撃の痕跡がないことを確認
してください。出荷に先立ち、機器は機械的損傷の有無を徹底的に検査されています。

注： 輸送が必要になった場合に機器を再梱包できるように、段ボール箱や梱包材は保管しておいてくださ
い。 (71 ページ 「修理のための機器の返送」 参照)。

4. 標準アクセサリおよびご注文のオプショナル・アクセサリがすべて届いていることを確かめてください
(62 ページ 「アクセサリ」 参照)。

動作条件
次の表は、MTS4000 システムの動作電源要件を示しています。MTS4000 型機器の動作電源要件の詳細
については、『MTS4000 型 MPEG テスト・システム仕様および性能検査に関するテクニカル・リファレンス』
を参照してください。

要件 仕様

動作時温度 + 5 ℃ ～ + 40 ℃

動作高度 0 ～ 2,000 m（6,562 フィート）

動作湿度 相対湿度 20% ～ 80%、結露なきこと

電源電圧 100 ～ 240 VAC ± 10%（90 ～ 264 VAC RMS）

周波数レンジ 50/60 Hz

最大消費電力 220W

ヒューズ ユーザによる交換不可。認定サービス担当者へ依頼してください。

過電圧カテゴリ II（IEC61010-1 の定義に基づく）

汚染度 2（IEC61010-1 の定義に基づく）。評価対象は屋内用途のみ

コントロールおよびコネクタ
このセクションでは MTS4000 システム機器のコントロールとコネクタについて説明します。解析機能（有効な
場合）は、電源を供給し、機器のハード・ディスク上でトランスポート・ストリームを利用できるようにするだけ
で使用できます。モニタとリアルタイム解析機能も同様に電源を必要としますが、外部トランスポート・ストリー
ムへの接続も必要となります。

MTS4000 システムは、購入時にご注文のソフトウェアおよびハードウェア・オプションで構成されます。
MTS4000 システムのオプションは、当社が提供するアップグレード・キットを使用して追加できます。
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注意： 過熱による装置の損傷を防ぐために、装置をベンチ上に置くときは、装置キャビネットの後部および
両側面に少なくとも 2 インチ（5.1 cm）のスペースを確保してください。

注意： その他の接続がすべて行われるまで、装置に電源を供給しないでください。

側面のコネクタ

次の図に MTS4000 システムのコネクタを示します。
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図の参
照番号 説明

図の参
照番号 説明

1 メイン DVI ディスプレイ・ポート（メイン
フレーム LCD へ）

セカンダリ DVI ディスプレイ・ポート 1, 2

6 PS/2 キーボード・コネクタおよびマウ
ス・コネクタ 1

2 ライン出力： メインフレームのスピーカ
に接続

ライン入力： 機能しません

マイク 1

7 オプションのインタフェース・カード用
ベイ

3 USB ホスト・ポート 8 RJ-45 LAN コネクタ

4 DVI、VGA ビデオ・コネクタ： 機能しま
せん

9 AC メイン電源スイッチ

5 COM 1 および COM 2 シリアル・ポート 10 AC メイン電源プラグ

設置場所に合った正しい電源コードを
使用してください。

1 このポートにケーブルを接続しての EMC 性能テストは行われていません。
2 セカンダリ・ディスプレイ・ポートを使用して、MTS4000 型ディスプレイを表示したり拡張することができます。機器の起動時に

ディスプレイを接続しておく必要があります。

フロント・パネル・コントロールおよびコネクタ

次の図と表に MTS4000 型のフロント・パネルのコントロールとコネクタを示します。
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図の参
照番号 説明

図の参
照番号 説明

1 電源インジケータ。スタンバイ・モード
のときに点滅します。

5 オン／スタンバイ・ボタン

2 ハード・ディスクの作動インジケータ 6 LCD コントロール

3 ディスプレイ ON/OFF ボタン 7 USB ホスト・ポート

4 再起動ボタン（凹型） 8 キーボード／マウス・コネクタ

オプション・カード用コネクタ

MTS4000 システムには、各種トランスポート・ストリーム、ネットワーク、および周辺機器をサポートするオプ
ションのカードを取り付けることができます。このセクションでは、各オプション・カードとそのコネクタについ
て説明します。

各オプション・カードのコネクタと信号の入出力フォーマットの詳細については、『MTS4000 型 MPEG テスト・
システム仕様および性能検査のテクニカル・リファレンス』を参照してください。

注： 機器には最大で 4 つのオプション・カードを取り付けることができますが、オプション S2、VS、QB2、
IPTV は 2 つのみ取り付けられます。

必ず USB ソフトウェア・キー（ドングル）をいずれかの USB ポートに取り付けてください。

注： MTS4000 システムのアプリケーションとインストールされているオプション・カードにはソフトウェア・キー
が必要です。

アップグレードや修理のためにテスト・システムを当社サービス受付センターに返送する場合は、ソフトウェ
ア・キーを添付してください。

表 1: オプション・カードとコネクタ

マルチポート ASI インタフェース（オプション ASI 型）

コネクタ：75 Ω BNC

DVB-S/S2 インタフェース（オプション S2 型）

QPSK 、 8PSK 、 16APSK 、 お よ び
32APSK の 復 調 を サ ポ ー ト す る
DVB-S/S2 インタフェース（オプション
ASI 型が必要）

8VSB インタフェース（オプション VS 型）
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ATSC A/53B準拠の 8VSB インタフェー
ス（オプション ASI 型が必要）

QAM B インタフェース（オプション QB2 型）

64QAM、256QAM インタフェース（オプ
ション ASI 型が必要）

10GBase-SR デュアル・オプティカル・ポート 10GB/S NIC（オプション 10GS 型）

10GBase-SR デュアル・オプティカル・
ポートの 10 Gbps NIC。短距離用 SFP+
およびモジュール（850 nm）を含む

IP ビデオ・インタフェース（オプション IPTV 型）

10／100／1000 Base-T RJ45 電気ポー
トの IPTV ギガビット・イーサネット・イン
タフェース（オプション ASI 型が必要）

SFP モジュール（オプション SX 型、LX 型、ZX 型）

1000 Base-SX 短波長光ポート、IPTV
イーサネット・インタフェース用 LC コネ
クタ付き（マルチモード 850 nm）

1000 Base-SX 長波長光ポート、IPTV
イーサネット・インタフェース用 LC コネ
クタ付き（シングル・モード 1310 nm）

1000 Base-ZX 光ポート、IPTV イーサ
ネット・インタフェース用 LC コネクタ付
き（シングル・モード 1550 nm）

ケーブルを接続していないときは、SFP モジュールに光ポート・プラグを必ず取り付けてください。

有害なレーザー光線にさらされるのを避けるため、米国の連邦規制 CDRH 21 CFR 1040 および IEC/EN
60825/A2:2001 で規定されているように、Class 1 レーザーのみを使用してください。

MTS4SA 型スタンドアロン・システムのインストール
MTS4SA 型スタンドアロン・システムを使用すると、MTS4000 システム・アプリケーションが PC 上で使用でき
ます。

MTS4SA 型には USB ドングルが付属します。USB ドングルにはキーが格納されており、PC に取り付けると
MTS4000 システムの各種ソフトウェア・オプションが利用できるようになります。USB ドングルに格納されてい
るキーは、購入したソフトウェア・オプションによって異なります。

オプション MTS4EA 型（MTS4EA Compressed Video ES Analyzer）を購入した場合は、付属のユーザ・マニュ
アル（『MTS4EA Compressed Video ES Analyzer ユーザ・マニュアル』、071-1641-xx）に記載のインストール
手順に従ってください。
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システム要件

MTS4SA 型スタンドアロン・システムのインストールには、次の最小 PC 構成が推奨されます。

Microsoft Windows XP または Windows 7 オペレーティング・システム

プロセッサ速度 >1.2 GHz

1 GB 以上の RAM

1024x768 以上の画面解像度

1 GB 以上のハード・ディスク容量

注： MTS4EA MPEG Compressed Video ES Analyzer アプリケーションは、上記の仕様の PC で十分に動作
します。ただし、リソースを集中的に使用する一部の操作は、より強力な PC を使用するとさらに快適に動作
します。詳細については、『MPEG Compressed Video ES Analyzer ユーザ・マニュアル』を参照してください。
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インストール手順

1. 同梱の USB ソフトウェア・キー（ドン
グル）が PC の USB ポートに差し込
まれていることを確認してください。

2. MTS4000アプリケーション・ソフトウェ
アのメディアを PC の DVD ドライブ
に入れます。

インストール・プログラムが開始さ
れ、Welcome という画面が表示され
ます。

Windows とセキュリティの設定によっ
ては、MTS4000 インストールが自動
的に開始しないことがあります。

必要な場合は Windows エクスプ
ローラを使用して、MTS4000 アプ
リケーション・ソフトウェア・メディア上
の MTS4000_setup.exe を探して実
行してください。

3. インストールの Welcome 画面で、
Next を選択します。

4. エンドユーザ・ライセンス契約書
（EULA）を読みます。契約書に同
意し、Next を選択します。
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5. Setup Type 画面で、PC へのインス
トールか MTS4000 型プラットフォー
ムへのインストールかを選択する必
要があります。

PC へのインストール：

Install on MTS4000 Platform チェッ
ク・ボックスをオフにします。

MTS4000 型プラットフォームへのイ
ンストール：

Install on MTS4000 Platform チェッ
ク・ボックスをオンにします。

注： Install on MTS4000 Platform をオ
ンにすると、インタフェース・カードに必
要なすべてのドライバがインストールさ
れます。

6. Next を選択します。

7. Ready to Install 画面で、Install を選
択します。

インストール時に MTS4000 ソフトウェア
の旧バージョンが検出されると、ソフト
ウェアは自動的にアンインストールされ
ます。

注： インストールの途中、メッセージ・ボックスが何回か表示されますが、通常、ユーザの操作は必要ありま
せん。
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8. そのままインストールを進めます。

9. Windows のセキュリティ設定によっ
て、デバイス・ソフトウェアをインストー
ルする際にセキュリティ・メッセージ
が表示されることがあります。Install
を選択します。

DESkey ソフトウェアがインストール
されている場合、このインストールの
ウィンドウは表示されません。
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10.WinPcap インストーラが表示された
ら、Next を選択します。

WinPcap のインストールを続けます。

正しいバージョンの WinPcap がす
でにインストールされていることが
検出された場合、WinPcap のインス
トールはスキップされます。

11.インストールの完了画面が表示され
たら、Finish を選択します。

アプリケーションを使用する前にリブー
トが必要です。
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12.PC を再起動したら、Start > Program
> Tektronix MTS4000 > OptionKey
Wizard を選択して、MTS4000 オプ
ション・キー・ウィザードを起動しま
す。

13.Tektronix Option Update ダイアロ
グ･ボックスで、インストレーション・マ
ニュアルと共に提供されたオプショ
ン･キー文字列を Key String フィー
ルドに入力します。

14.Apply をクリックします。

15.ライセンス・オプションのリストを調べ
て確認します。

注： 各機能へのアクセスは、ソフトウェア・キーで利用可能なライセンスによって制御されます。アプリケー
ションおよび機能はインストールできますが、適切なライセンスが取得されるまで使用できません。これらのこ
とは、製品または追加ライセンスを購入するときにお知らせしています。

MTS4EA 型および MTS4CC 型のライセンスは USB ドングルに格納されています。VQS および PQA ソフト
ウェアには個別のライセンスが必要です。

16.Option Key Wizard を閉じます。

17.これでライセンスされた MTS4000 ス
タンドアロン・アプリケーションが、
Windows のスタート・メニューで使
用できるようになりました (25 ページ
「アプリケーションの起動」 参照)。

機器の電源の投入

電源の供給

MTS4000 システムは、単相電源（そのうちの 1 本はアース（近傍）電位の中性線）で動作するように設計され
ています。相間や多相方式など、2 本の導体がグランドに対して相電圧を持つ電源はお勧めできません。
操作の安全のために、電源コードの接地用導体を通じた保安用グランド接続が必須です。

MTS4000 システムを設置して信号および周辺装置の接続が完了したら、電源コードをメイン電源に差し込
みます。
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電源投入

テスト・システムの電源は次のようにしてオンにします。

1. キーボード・ロックを上にスライドさ
せます。

2. キーボードを開きます。

3. フロント・パネルのオン／スタンバ
イ・スイッチを押して、機器の電源を
入れます。

注： リア・パネルのメイン・スイッチが
入っていることを確認してください。

電源投入時のセルフテストが完了する
まで待ちます。

デフォルトのユーザ名は"MTS"、パス
ワードは "mts" です。

注： ユーザ・アカウントとパスワードの
設定については、Windows のヘルプ・
ドキュメントを参照してください。
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キーボードの取り外し

1. キーボード・ピンを内側にスライドさ
せます。

2. MTS4000 型のケースからキーボー
ドを外側にスライドさせます。

機器の電源の切断
フロント・パネルのオン／スタンバイ・ボタンを押して離します。以上の操作でシステムは自動的にシャット・
ダウンし、電源が切れます。

または、Windows XP のシャットダウンを使用して機器の電源をオフにします（Start > Shut down... を選択）。
システム（アプリケーションを含む）が自動的にシャット・ダウンします。

機器が応答しなくなった場合は、オン／スタンバイ・ボタンを 5 秒間押し続けてください。これにより、Windows
の電源切断シーケンスを省いて、機器の電源が強制的に切られます。
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VLC Media Player のインストール
Transport Stream Compliance Analyzer（TSCA）でビデオを見られるようにするには、VideoLAN の Web サイ
トから最新バージョンの VLC Media Player をダウンロードしてインストールする必要があります。

1. インターネットにアクセスできる
PC または MTS4000 型機器を使
用して、VideoLan の Web サイト
（http://www.videolan.org）に移動し
ます。

2. Windows 自己解凍形式のVLCMe-
dia Player のインストーラを探して PC
のハード・ディスクにダウンロードし
ます。

3. 機器上にダウンロードされた VLC
Media Player ファイルを探して実行
します。

4. 使用する言語を選択します。Wel-
come / Setup 画面が表示されます。

5. セットアップ手順に従って、VLC
Media Player をインストールします。

これで、必要な作業が終了しました。VLC Media Player は必要に応じて TSCA アプリケーションから使用さ
れます。

ネットワーク構成
MTS4000 システムは、コンピュータ・ネットワークに接続することができます。正しいネットワーク設定の詳細
については、ネットワーク管理者に問い合わせてください。インストールおよび操作手順については、ご使
用のネットワーク・ハードウェアおよびソフトウェアに付属のドキュメントを参照してください。

ネットワークのトラブルシューティング

ネットワークは各種規格に基づいていますが、各ネットワーク（LAN または WAN）には固有の特性が多数
存在するため、特定のネットワークに関する十分な知識がないとトラブルシューティングは困難になります。
そのため、ネットワークの詳細なトラブルシューティングは、そのネットワークの特性に精通している専門家
が実行すべきです。

このセクションでは、ネットワーク・エラーの一般的ないくつかの原因を解消できる基本的な手順を紹介しま
す。これらの手順を使用しても問題を解決できない場合は、ネットワーク管理者にお問い合わせください。
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基本的な要件

ホスト・マシンのトラブルシューティングを行う前に、次の要件が満たされるようにしてください。

接続するネットワークに合わせてシステムを設定します。詳細については、ネットワーク管理者にお問い
合わせください。MTS4000 型の NIC は DHCP でアドレスを自動割当するように設定されています。

テスト・システムの購入後にインストールしたアプリケーションの中に、テスト・システム・コンポーネントに
割り当てられたポートを使用しているものがないかを確認します。

IP パラメータ

このセクションでは、各 IP パラメータ（IP アドレス、サブネット・マスク、およびデフォルト・ゲートウェイ）がネッ
トワーク接続におよぼす悪影響を図で説明します。

IP アドレスの誤り: テスト・システムの IP アドレスが正しくない（固有でない）場合は、ネットワーク上で通信
できない可能性があります。次の図では、TVTest_1 が Rennes と同じ IP アドレスを使用しています。Rennes
が最初に起動されると、TVTest_1 は IP アドレスの競合を認識し、TCP/IP をロードしません。この結果、ネッ
トワーク経由でシステムに到達できません。

IP アドレスが正しくなく、サブネット上に存在しない場合でも、デバイス（システムまたは監視ステーション）か
らの通信は可能な場合がありますが、デバイスへの通信は不可能になる場合があります。

サブネット・マスクの誤り: サブネットやサブネットを含むネットワークは複雑であり、IP アドレス指定につ
いての十分な知識を必要とします。発生しているネットワークの問題にサブネットが関係していると思われる
場合は、ネットワーク管理者にお問い合わせください。次の図は、単純な（比較的よく見られる）サブネット・
マスクの問題を示しています。
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図の TVTest_1 のサブネット・マスクは、ネットワーク・アドレスが IP アドレスの最初の 2 バイトに含まれている
ことを示しています。ドット区切りの 10 進表記では、ネットワーク・アドレスは 128.181 です。この情報により、
デバイスはデフォルト・ゲートウェイ経由でルーティングされなくても、同じネットワーク・アドレスを持つ他の
デバイスと通信できます。

TVTest_1 は Carnac とは通信できません。これは、TVTest_1 のサブネット・マスクによると、Carnac と TVTest_1
が論理的に同じネットワーク上に存在するためです。この結果、TVTest_1 から Carnac に送信されたメッセー
ジはルーティングされなくなります。この 2 つのデバイスが接続を共有していないため、TVTest_1 は Carnac
のネットワーク・カードの正しいアドレスを見つけることができず、Carnac には到達できません。

TVTest_1 は、TVTest_2 および Rennes とは通信できます。それは、これら 3 つのデバイスが接続を共有し
ているため、TVTest_1 からのメッセージをルーティングする必要がないためです。したがって、正しくないサ
ブネット・マスクが設定されているにもかかわらず、TVTest_1 は TVTest_2 および Rennes の正しいアドレスを
見つけることができます。
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デフォルト・ゲートウェイの IP アドレスの誤り:

TCP/IP Properties ダイアログ・ボックスで指定したデフォルト・ゲートウェイは、ネットワーク上の各サブネット
ワークを "認識している" デバイスです。メッセージ（たとえば、あるシステムから他のサブネット上のデバイス
へのトラップ）を送信する場合、デフォルト・ゲートウェイはそのメッセージを適切なサブネットにルーティング
できます。TCP/IP Properties ダイアログ・ボックスで指定した IP アドレスが間違っていると、他のサブネット
上のデバイスへのメッセージは（デフォルト・ゲートウェイまで届かないため）宛先には到達しません。

一般的なトラブルシューティング手順

以降のセクションで実行する手順の多くは、一般的な作業です。

ホスト・マシンへの Ping: すべての TCP/IP インストールに提供されるユーティリティの 1 つに ping.exe が
あります。このユーティリティでは、ホスト・マシンに通信パケットを送信し、そのマシンからの応答を記録でき
ます。この操作により、パケットが宛先に到達したかどうかが判別されます。

注： Windows ファイヤウォールを無効にしない限り、MTS4000 型で ping ユーティリティは動作しません。
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Ping を実行するには、次の手順を使用します。

1. 次のキーを同時に押します。

Windows キー（ ） + R

これにより、Run ダイアログが表示され
ます。

2. Run のテキスト・ボックスに、次のい
ずれかを入力します。

ping Machine_Name

ping IP_address

この例では、Machine_Name と IP_ad-
dress がそれぞれ、ping 先のネットワー
ク・デバイスのホスト・マシン名と IP アド
レスを表しています。

3. OK をクリックします。

DOS ウィンドウに、マシンが ping に
応答しているかどうかが示されます。

Ping は短時間だけ実行され、プロ
セスが完了すると DOS ウィンドウは
閉じられます。
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TCP/IP パケットのルートのトレース:

パケットが、宛先マシンまでの経路のどこまで到達したかや、その途中でパケットがどのデバイスを通過したかが
分かると便利な場合があります。この機能を提供するユーティリティが tracert.exe です。tracert は、ネットワーク
内の混雑したポイントを示すこともできます。tracert を実行するには、次の手順を使用します。

1. 次のキーを同時に押します。

Windows キー（ ） + R

これにより、Run ダイアログが表示され
ます。

2. Run のテキスト・ボックスに、次のい
ずれかを入力します。

tracert Machine_Name

tracert IP_address

こ の 例 で は 、 Machine_Name と
IP_address がそれぞれ、到達先の
ネットワーク・デバイスのホスト・マシ
ン名と IP アドレスを表しています。

3. OK をクリックします。

DOS ウィンドウは、パケットの進行
状況を示しています。右端の列は、
tracert パケットを正常に通したネッ
トワーク上のノードの IP アドレスを
示しています。この情報は、宛先デ
バイスまでの経路上にある最後の
正常なノードを示しています。
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ネットワーク上のデバイスの IP アドレスの調査:

ネットワーク上のコンピュータの IP アドレス（または、IP アドレスが分かっている場合はネットワーク名）の調査が
必要となる場合があります。この情報が得られると、Hosts ファイルで使用している IP アドレスやネットワーク名が
正しいかどうかを確認できます。ユーティリティ nslookup.exe でこの情報が得られます。

1. 次のキーを同時に押します。

Windows キー（ ） + R

これにより、Run ダイアログが表示され
ます。

2. Run のテキスト・ボックスに、次のい
ずれかを入力します。

nslookup Machine_Name

nslookup IP_address

Machine_Name または IP_Address は、
それぞれ調べたいデバイスのネットワー
ク名または IP アドレスです。

3. OK をクリックします。

目的のデバイスのネットワーク名と IP ア
ドレスが表示されます。ネットワークで
DNS を使用している場合は、DNS サー
バの IP アドレスとネットワーク名も表示
されます。

注： Run コマンドで nslookup を使用す
ると、結果が表示される時間が短すぎ
ることがあります。クライアント PC 上で
コマンド・プロンプトのウィンドウを開きま
す（Start > All Programs > Accessories
> Command Prompt）。

ネットワーク情報の入手先

ネットワークのトラブルシューティングに関してさらに多くの情報が必要な場合、次のリソースが役立つ可能
性があります。
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Cisco Systems, Inc. – http://www.cisco.com/

このサイトは特に、Cisco 製デバイスを使用しているネットワークに役立ちます。

Dulaney, E、Lawrence, S、Scrimger, R、Tilke, A、White, J、Williams, R、Wolford, K 著、『MCSE Training
Guide:TCP/IP』。Indianapolis, IN. New Riders, 1998

これは、MCSE（マイクロソフト認定システムエンジニア）資格のためのトレーニング・ガイドで、TCP/IP と
ネットワークのトラブルシューティングを扱っています。

Taylor, E.著、『Network Troubleshooting Handbook』New York, NY.McGraw-Hill, 1999

注： これらのリソースから多くの情報が得られますが、その大部分はそのまま提供されており、その適合性
については、書面または黙示を問わず保証されていません。ネットワークに関するトラブルシューティング情
報の最善の入手先は、担当のネットワーク管理者です。
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製品の説明
MTS4000 型 MPEG テスト・システムには、リアルタイム解析および事後解析（デファード）に必要なすべて
のツールが用意されています。これらのツールには、TS（トランスポート・ストリーム）コンプライアンス、バッ
ファ、PES、MPEG2、および MPEG4 のビデオおよびオーディオ・エレメンタリ・ストリーム・アナライザがありま
す。ストリーム・コンテンツやテストおよびエラー・ストレス・ストリームを作成するためのエディタおよびマルチ
プレクサもあります。

MTS4000 解析ツールセットの各アプリケーションは、トランスポート・ストリームの特定の側面または層を対象
としています。以下の図は、この原理を簡略化された形で示しています。

「手順」のセクションでは、アプリケーションの開始方法、テストストリームの解析方法、結果の表示について
説明しています。結果の解釈方法については説明しません。

批准された DTV 規格や更新される DTV 規格を幅広くサポートするカスタマイズ可能な組込みスクリプトを
通して、規格への適合性が保証されます。新しい規格や独自仕様のテーブルは、当社が提供する更新を
読み込むか、または独自のカスタム・スクリプトを作成することにより簡単に実装できます。
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ソフトウェア・アプリケーション
このセクションでは、MTS4000 型 MPEG テスト・システムを構成するソフトウェア・アプリケーションの概要を
簡単に説明します。一部のオプションが有効になっていない場合があることに注意してください。すべてのア
プリケーションに関する詳細な説明は、『MTS4000 システム MPEG テスト・システム・アプリケーション・ユー
ザ・マニュアル』を参照してください。

アプリケーション
デスクトップ・
アイコン 1

アナライザ

Transport Stream Compliance Analyzer（TSCA）： リアルタイムおよび事後のトランスポート・
ストリーム解析。MPEG-2、DVB、および ATSC から適合テスト項目を選択可能です。トラ
ンスポートの構造、ヘッダの内容、パケットの内容の 16 進表示、PCR タイミング／トランス
ポート・レート・グラフ、およびエラー・メッセージ・ログを表示します。

MTS4000 型テスト・システムに取り付ける最初の RF/IP カードは ASI カードの上に取
り付けます。この RF/IP カードには、スタート・メニューとデスクトップの TS Compliance
Analyser アイコンを使用してアクセスできます。

MTS4000 型テスト・システムに取り付ける 2 番目の RF/IP カードは ASI カードの下に取
り付けます。この RF/IP カードには、デスクトップの TS Compliance Analyser P1 アイコン
を使用してアクセスします（スタート・メニューに TSCA P1 のアイコンはありません）。

Packetized Elementary Stream (PES) Analyzer：選択可能なテスト・オプションを持つ PES 解
析。PES プログラム構造、ヘッダの内容、パケットの内容、PTS/DTS タイミング・グラフ、お
よび解析レポートを表示します。

Transport Stream System Target Decoder （T-STD）Buffer Analyzer： MPEG-2 T-STD バッ
ファ・モデルにおける、プログラム・ストリームの振る舞いをモデリングし、それに対する適合
性を解析します。トレース機能も搭載されています。

Elementary Stream Analyzer：ビデオ映像およびオーディオ・レベルでのエレメンタリ・ストリー
ム解析。これには、ベクトル・グラフとマクロブロックのピクチャ品質が含まれます。

Carousel Analyzer：データ項目の構造、ビット・レート、反復率、構文、およびセマンティク
スを表示するデータ解析。
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アプリケーション
デスクトップ・
アイコン 1

ゼネレータ

Carousel Generator：さまざまなデータ放送プロトコルを含む MPEG-2 および DVB トランス
ポート・ストリームをオフラインで詳細に生成します。

Multiplexer：テーブル情報とパケット化エレメンタリ・ストリームを多重化し、新しいトランス
ポート・ストリームを合成します。新しいトランスポート・ストリームに対して非適合性およびテ
スト・ケースを指定できるように、きめ細かい制御が可能です。

TS Editor：パケット内容の 16 進表示とヘッダのセマンティクス解釈を使用して、トランスポー
ト・ストリーム・パケットの表示および編集を行います。PID の再マッピング、PCR 値の再計
算、PCR 誤差の導入などの機能を提供します。

プレーヤ

MPEG Player： MPEG-2 トランスポート・ストリームを再生します。

ユーティリティ

Make Seamless Wizard： ストリーム・プレーヤの連続ループ･モードで使用する MPEG-2 ト
ランスポート・ストリームのファイルの作成手順を案内します。

Stream Cutter： MPEG-2 トランスポート・ストリーム・ファイルの一部を切り取って新しいファ
イルに抽出します。

Script Pad：ユーザがシステム情報（SI）スクリプトの作成と変更を行えるようにします。

TTS Utility：タイム・スタンプ付きのトランスポート・ストリームを標準的なトランスポート・スト
リーム形式に変換します。

1 インストール済みでライセンスがある場合。

24 MTS4000 型および MTS4SA 型クイック・スタート・ユーザ・マニュアル



操作

アプリケーションの起動
アプリケーションはすべて、デスクトップのショートカットか、Start > All Programs > Tektronix MTS4000 メ
ニューから起動します。

MTS4000 システム・アプリケーションの各ユーザ・マニュアルに、アプリケーションの説明が記載されています。
以下の表は、スタート・メニューのアプリケーション階層を示しています。

メニュー階層

OptionKey Wizard

Analyzers > Buffer Analyzer

Carousel Analyzer

ES Analyzer

PES Analyzer

TS Compliance Analyzer

Carousel Generator

Multiplexer

Generators >

TS Editor

Player > MPEG Player

Make Seamless Wizard

ScriptPad

Stream Cutter

Tektronix MTS4000 >

Utilities >

TTS Utility

注： スタート・メニューに表示されるアプリケーションのうち、開くことができるオプションは購入済みのもの
だけです。

デュプレックス操作
MTS4000 システムはデュプレックス・モードで操作できます（ASI または SPI のみ）。たとえば、プレーヤがス
トリームを再生しているときに、Transport Stream Compliance Analyzer（TSCA）は別のストリームを解析できま
す。また、出力を入力へループバックすると、プレーヤの出力を TCSA でモニタできます。

セットアップ、ループバック

ループバックを実行すると、次のことが可能になります。

MPEG Player を使用してストリームを再生する

機器の出力を入力にループバックする（たとえば、ASI カードで ASI-4 を ASI-3 にループします。10G
カードで LC マルチモード・ジャンパ・ケーブルを使用して出力を入力にループします）

TSCA を使用して入力ストリームをモニタ／解析する

開始する前に：
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再生するストリームを決定する（この例では、sym1.mpg テスト・ストリームを使用）

入出力インタフェース（ASI）を選択し、必要な接続（コネクタ間のループ）を行う

次の例では、ASI インタフェースを使用してストリームをループ・バックし、ストリームをプレーヤ内でループし
ます（連続再生のために）。

MPEG Player のセットアップ:

1. MPEG Player を開きます：Start > All Programs >Tektronix MTS4000 >Player >MPEG Player の順に選択
します。

2. ストリームを開きます：File > Open... > Sym1.mpg.

注： Sym1.mpg ファイルは、MTS4000 アプリケーションの理解を支援する目的で提供されています。ファイ
ルは、MTS4000 型のハード・ディスク（c:\TestStreams）、Tclips MPEG テスト・ストリーム DVD、およびマニュ
アル・ブラウザ CD など、いくつかの場所にあります。

3. Play メニューで次の設定を行います。

Packet size： 188

Update：On

Sync：TS Packet

Loop：On

Other：Standard：DVB

TSCA のセットアップ:

1. TSCA を開きます：Start > All Programs >Tektronix MTS4000 >Analyzers >TS Compliance Analyzer の順
に選択します。

2. 最初に表示されるOpen Transport Stream... ダイアログ・ボックスの Stream Interpretation で、Change...
を選択し、拡張機能のない DVB ベース規格を選択します。Stream Interpretation ダイアログ・ボックスを
閉じます。

3. Real-time Analysis を選択し、Interfaces ドロップダウン・リストから ASI を選択します。

4. OK を選択します。

再生と解析の開始:

1. MPEG Player のウィンドウに戻り、次の手順でストリームを再生します。Play > Start/Stop またはツール・
バー・ボタンを使用します。

2. プレーヤ・ウィンドウでは、ステータス・バーが表示され、再生が開始されています。

3. TSCA ウィンドウに戻ると、解析が開始されています。

MPEG Player は sym1.mpg トランスポート・ストリームを再生中であり、TSCA は、機器のコネクタ・パネルの
ASI 入力および出力を介してストリームをモニタし解析しています。

MPEG Player および TSCA の詳細については、『MTS4000 アナライザ・アプリケーション・ユーザ・マニュア
ル』を参照してください。
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手順

Multiplexer の使用
次のアプリケーション例では、Multiplexer を使用して新規トランスポート・ストリームを作成し、エレメンタリ・ス
トリームをトランスポート・ストリームに追加します。

この手順で作成される新規トランスポート・ストリーム（名前 TestMux.mpg）は、このマニュアル内で追加のい
くつかの手順で使用されます。

Multiplexer を使用した新規ストリームの作成

使用例のこのセクションでは、MTS4000 Multiplexer アプリケーションを使用して新しいトランスポート・ストリーム
を作成します。意図的にエラーを 1 つ加えて、使用例の後のセクションでその影響を確認できるようにします。

1. Multiplexer アプリケーションを開く
には、Start > Programs > Tektronix
MTS4000 > Generators > Multi-
plexer の順に選択します。

2. View > Interpretationを選択します。

3. Stream Interpretation ダイアログ・
ボックスで、Base Standard として
DVB が選択され、Region が None
になっていることを確認します。

4. OK を選択して、Stream Interpreta-
tion ダイアログ・ボックスを閉じます。
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5. File > New を選択します。

6. Navigator ウィンドウで、トランスポー
ト・ストリームのノードをハイライトし、
コンテキスト・メニューから Properties
を選択します。

7. Stream Properties ダイアログ・ボッ
クスで、ビット・レートとして 24.128
MBps を入力し、固定継続期間とし
て 2 分（120 秒）を入力します。OK
を選択します。

この 2 つの値がステータス・バーに
表示されていることに注意してくだ
さい。

8. Navigator ウィンドウで、トランスポー
ト・ストリームのノードをハイライトし、
コンテキスト・メニューから Add を選
択します。
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9. Transport Stream Settings ダイアロ
グ･ボックスで、トランスポート・スト
リームの ID として「1」を入力しま
す。

10.PAT（Program Allocation Table）フォ
ルダ・アイコンのボタンを選択して、
PAT Timing ダイアログ・ボックスを
開きます。

Version Timing タブ・ウィンドウに表
示されている PAT タイミングの Start
Time（0 秒）と Stop Time（120 秒）
は、PAT がこのストリーム期間で送
信されることを意味しています。

11.OK を選択して、PAT Timing ダイア
ログ・ボックスを閉じます。

12.Transport Stream Settings ダイアロ
グ・ボックスで、Next を選択します。

13.Optional Tables for the Stream ダイ
アログ・ボックスで、TDT（Time and
Date Table）チェック・ボックスを選
択し、TDT フォルダ・アイコンのボタ
ンを選択します。
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TDT Timing ダイアログ・ボックスで、
Start Time がゼロに設定され、Stop
Time が前に設定した継続期間と同
じ値に設定されていることを確認し
ます。

この継続期間は、若干調整されて
いる場合があることに注意してくだ
さい。この例では、120 秒と設定し
た継続期間が 119.999976127 と表
示されています。

14.Cycle Time に「1000」ms と入力しま
す。

15.OK を選択して、TDT Timing ダイア
ログ・ボックスを閉じます。

16.Optional Tables for the Stream ダ
イアログ・ボックスで、NIT（Network
Information Table）チェック・ボックス
を選択し、NIT の Settings ボタンを
選択します。

17.Set up the NIT ダイアログ･ボック
スで、Network Id に「1234」、また
Network Name に「Tek_test」と入力
します。

18.Original Network Id を 2 に設定し、
Delivery System ドロップダウン・リス
トから Terrestrial を選択します。

19.Delivery System の Settings ボタン
を選択します。
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20.Terrestrial Settings ダイアログ･ボッ
クスで、Centre Frequency フィール
ドに「0x123456」と入力します。

21.Constellation ドロップダウン・リスト
から 2 (64-QAM) を選択します。

22.Hierarchy Info ドロップダウン・リス
トから 4 (non-hierarchical, in-depth
interleaver) を選択します。

23.Transmission Mode ドロップダウン・
リストから 1 (8k mode) を選択しま
す。

24.OK を選択して、Terrestrial Settings
ダイアログ・ボックスを閉じます。

25.OK を選択して、Set up the NIT ダ
イアログ・ボックスを閉じます。

26.Optional Tables for the Stream ダイ
アログ・ボックスで、Next を選択す
ると、Transport Wizard Complete ダ
イアログ・ボックスが表示されます。

以上でトランスポート・ストリームのセット
アップは完了です。ここで、何らかのコ
ンテンツをビデオ・エレメンタリ・ストリー
ムおよびオーディオ・エレメンタリ・スト
リームの形式で追加する必要がありま
す。

Transport Wizard Complete 画面は閉
じないでください。
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エレメンタリ・ストリームのアクイジション:

この例では、作成したトランスポート・ストリームに、ビデオ・エレメンタリ・ストリームとオーディオ・エレメンタリ・スト
リームを追加する必要があります。MTS4000 インストールに付属しているサンプルのトランスポート・ストリームの
いずれかから適切なストリームを解凍できます。この例で使用するストリームは Sym1.mpg です。このファイルは、
MTS4000 型のハード・ディスク、Tclips MPEG テスト・ストリーム DVD、およびマニュアル CD にあります。

1. マルチプレクサの 2 つ目のインスタ
ンスを開きます。Start > Programs >
Tektronix MTS4000 > Generators >
Multiplexer の順に選択します。

2. File > Open を選択します。

3. Set MPEG File to Edit ダイアログ･
ボックスで、sym1.mpg を検索して開
きます。

4. プログラム 1 のノードと、その下の
エレメンタリ・ストリーム・ノードを展
開します。

5. PID 110 ノードをハイライトします。
この PID は、MPEG-2 ビデオ・エレ
メンタリ・ストリームを伝送します。

6. コンテキスト・メニューから Export
Elementary Stream を選択します。

7. Save As ダイアログ･ボックスで、ファ
イル名（「Sym1pid110.es」）を入力
し、適切な場所にファイルを保存
します。

8. PID120 にも 、同様の手順を繰
り返します。ファイルの名前は
Sym1pid120.es にします。

9. File > Exit を選択して、Multiplexer
のこのインスタンスを閉じます。

以上で、ビデオ・エレメンタリ・ストリーム
とオーディオ・エレメンタリ・ストリームの
解凍は完了です。続けて多重化タスク
を実行できます。
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追加、エレメンタリ・ストリーム:

これで、元のマルチプレクサのインスタンスに戻り、先程作成したエレメンタリ・ストリームを追加できます。

1. Add a Program Wizard がオンになっ
ていることを確認し、Next を選択し
ます。

2. Add a Program ダイアログ・ボックス
で、プログラム番号として 1 を入力
します。

3. PMT フォルダのアイコンを選択しま
す。

4. PMT Timing ダイアログ・ボックスで、
Subtable Timing タブを選択します。

サブテーブル・タイミング・サイクル
時間とは、ストリーム内でテーブルが
繰り返される期間のことです。DVB
規格における PMT の最大サイクル
時間は 500 ms です。

5. このストリーム例では、サイクル・タ
イムを「525」ms に設定します。

6. OK を選択して、PMT Timing ダイア
ログ・ボックスを閉じます。

7. Add A Program ダイアログ・ボックス
で、Next を選択します。
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8. Add Service Description ダイアログ・
ボックスで、Add Service Description
チェック・ボックスを選択します。

9. Service Provider Name に（ 「 Tek
Broadcasting」 など）を入力します。

10.Service Name に（「Tek1」 など）を入
力します。

11.Service Type に（「1 (0x1) (digital
television service) 」など）を入力し
ます。

12.Next を選択します。

13.Add the Program Content ダイアロ
グ・ボックスで、Add を選択し、ビデ
オ・エレメンタリ・ストリームを追加し
ます。

14.Add Program Stream ダイアログ･ボッ
クスで、Stream Type ドロップダウン・
リストから 2 (0x02) (MPEG-2 Video)
を選択します。

15.Source タブが選択されていることを
確認します。

16.File name を入力するか、Browse
を使用して以前セットアップした
ビデオ・エレメンタリ・ストリーム
（Sym1pid110.es）を探します。

17.File type ドロップダウン・リストで
MPEG-2 video を選択します。ファ
イルのビット・レートは自動的に入力
されます。
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Timing タブを選択します。エレメン
タリ・ストリームは、以前に設定した
ストリーム長、つまり 120 秒間実行
されることに注意してください。

18.PCR タブを選択します。Carry PCR
チェック・ボックスが選択されている
ことを確認します。
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19.OK を 選 択 し て 、 Add Program
Stream ダイアログ・ボックスを閉じ
ます。

20.Add the Program Content ダイアロ
グ・ボックスで、Add を再度選択し、
オーディオ・エレメンタリ・ストリーム
を追加します。

21.Stream Type ドロップダウン・リストか
ら 3 (0x03) (MPEG-1 Audio) を選択
します。

22.Add Program Stream ダイアログ･ボッ
クスで、Source タブが選択されてい
ることを確認します。

23.File name を入力するか、Browse ボ
タンを使用して以前セットアップした
オーディオ・エレメンタリ・ストリーム
（Sym1pid120.es）を探します。

24.File type ドロップダウン・リストから
MPEG-2 audio を選択します。ファ
イルのビット・レートは自動的に入力
されます。

25.Timing タブを選択します。エレメン
タリ・ストリームは、以前に設定した
ストリーム長、つまり 120 秒間実行
されることに注意してください。

26.PCR タブを選択します。Carry PCR
チェック・ボックスがオフになってい
ることを確認します。

27.PCR PID フィールドに「33」と入力し
ます。これは PCR 情報を含む PID
であり、ビデオ es、PCR のキャリー
も含まれます。

28.OK を 選 択 し て 、 Add Program
Stream ダイアログ・ボックスを閉じ
ます。

29.Next を選択します。
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30.Event Information ダイアログ・ボッ
クスで、Event Information Tables
(EIT) チェック・ボックスを選択しま
す。

31.Present チェック・ボックスが選択さ
れていることを確認します。

32.Present Settings を選択します。

33.Present Events ダイアログ・ボックス
で、Add を選択して、現在のイベン
ト情報、つまり、この放送の時間を
セットアップします。Event ダイアロ
グ・ボックスで、Status ドロップダウ
ン・リストから 4 (running) を選択しま
す。

34.Start Time を 2008-08-28 10:20:00
AM に設定します。

時間と日付は、各フィールドをハイ
ライトし、必要な値を入力することに
より変更できます。

35.Event Name に（「Tek World」 など）
を入力します。

36.Description に（「The future of Tek」
など）を入力します。

37.Duration に（30 分（「00:30:00」）な
ど）を入力します。

38.Content/Component Type ドロップ
ダウン・リストから 257 (MPEG-2
video, 4:3 aspect ratio, ...) を選択
します。

39.OK を選択して、Event ダイアログ・
ボックスを閉じます。

40.OK を選択して、Present Events ダ
イアログ・ボックスを閉じます。
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41.Following チェック・ボックスが選択
されていることを確認します。

42.Following Settings を選択します。

43.Add を選択して、後続のイベント情
報、つまり、現在のイベントに続くイ
ベントをセットアップします。

44.Event ダイアログ･ボックスで、Event
Id フィールドに「1」と入力します。

45.Status ドロップダウン・リストから 1
(not running) を選択します。

46.Start Time を 2008-08-28 10:50:00
AM に設定します。

47.Event Name に（Tek News など）を
入力します。

48. イベントの Description に（All the
latest news from Tek など）を入力し
ます。

49.Duration に（30 分（01:00:00）など）
を入力します。

50.Content/Component Type ドロップ
ダウン・リストから 257 (MPEG-2
video, 4:3 aspect ratio, ...) を選択
します。

51.OK を選択して、Event ダイアログ・
ボックスを閉じます。

52.OK を選択して、Following Events ダ
イアログ・ボックスを閉じます。

53.Event Information ダイアログ画面で
Next を選択します。
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54.Program Complete ダイアログ・ボッ
クスで、Finish を選択します。

トランスポート・ストリームの構造とコン
テンツの作成が完了しました。以上で、
いくつかのチェックを行って、ストリーム
が正常にコンパイルされることを確認で
きるようになりました。

55.View > Available Bitrate を選択しま
す。

Available Bitrate のグラフで、ビット・
レートが必要なビット・レート（つまり、
124.128 Mbps）内に収まっているこ
とに注意してください。

グラフ上の任意の点におけるビット・
レートを調べるには、その点をクリッ
クし、隣のテーブルから値を読み取
ります。

56.Available Bitrate のグラフを閉じま
す。

57.Multiplex > Start を選択して、多重
化を開始します。
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58.Set TS Output File... ダイアログ･
ボックスで、新しい多重化トラン
スポート・ストリームの名前として
「TestMux.mpg」を入力します。（こ
の新規トランスポート・ストリームは
他の手順でも使用します）。

多重化の進捗状況はステータス・
バーの右側に表示されます。ウィン
ドウの水平方向のサイズが小さすぎ
る場合、進捗状況バーが非表示に
なることがあります。

以上で、エレメンタリ・ストリームと
構造情報が 1 つに多重化され、
TestMux.mpg というトランスポート・
ストリームが作成されました。

59. この多重化の構造は、後で必要に
応じて呼び出したり、情報を追加し
たりできるよう、保存しておくことを
お勧めします。

60.File > Export... を選択します。

61.Export File ダイアログ・ボックス
で、多重化構造ファイルの名前
（TestMux.muxml など）を入力し、
ファイルを保存する場所を選択しま
す。muxml という拡張子に注意して
ください。

62.File > Import を使用すると、いつで
も多重化構造ファイルを開いて、エ
レメンタリ・ストリームや構造情報を
追加することができます。
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Transport Stream Compliance Analyzer の使用
次の手順では、Transport Stream Compliance Analyzer（TSCA）のファイル解析モードを使用して、トランス
ポート・ストリームをオフラインで調べます。手順では、「Multiplexer の使用」で作成したトランスポート・スト
リーム（TestMux.mpg）を使用します。

ライブ･データを解析するにはリアルタイム解析を使用します (60 ページ 「複数入力のモニタ」 参照)。

1. Transport Stream Compliance Ana-
lyzer を開くには、File > Program >
Tektronix MTS4000 > Analyzers >
TS Compliance Analyzer の順に選
択します。

Open File Analysis ダイアログ・ボッ
クスが自動的に開きます。表示され
ない場合は、TSCA Analysis ツール
バーの File Analysis を選択します。

Open File Analysis ダイアログ･ボッ
クスで、Base Standard が DVB とな
り、また Region が No Extensions に
なっていることを確認します。

2. サンプル・ストリーム（TestMux.mpg）
を探して、選択します。

Advanced Settings フィールドで、Stream
Bit Rate および Timestamp Settings が
右図のようになっていることを確認しま
す。
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3. 解析が完了するまでには、しばらく
かかります。

4. Analysis タブを選択し、ナビゲーショ
ン・ビューおよび関連するビューを
表示します。

5. Programs タブを選択し、プラス記号
をクリックしてナビゲーション・ビュー
の各ノードを展開します。

詳細ビューで、Summary ビューと
Tests ビューが表示されていること
を確認します。

トランスポート・ストリームのノードとプ
ログラムのノードが両方とも赤くなっ
ています。これは、そのストリームで
エラーが発生し、現在もアクティブ
であることを示しています。

6. トランスポート・ストリーム・ノードを
ハイライトします。Tests Summary 詳
細ビューの TR 101 290 タブで、test
1.5.a PMT がエラーを示しており、
関連する LED が赤くなっていること
に注意してください。
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7. テスト 1.5.a PMT をハイライトし、
Tests ツリーでコンテキスト・メニュー
から View this test を選択します。

Tests タブのビューが表示されます。
ナビゲーション・ビューが展開され、
エラーになったテストが表示されま
す。詳細ビューには、ハイライトされ
たテストに関連する PID（この例の
場合は、なし）が表示されます。さら
に、ハイライトされたテストに関する
イベントのみを表示するようフィルタ
リングされたイベント・ログが表示さ
れます。

ログ・エントリにエラー情報があるか
どうかを検証します。エラー・レポー
トでは 525 ms という継続期間を参
照していることに注意してください。
これは、PMT セクションの反復レー
トです。525 ms は、以前に作成した
サンプル・ストリームで設定した値で
す。
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8. ナビゲーション・ビューで 1.5 PMT
(Timer) テストをハイライトし、コンテ
キスト・メニューから Edit Parameters
を選択します。

9. Edit Parameters ダイアログ･ボック
スで、このストリームに対して PMT
section maximum repetition interval
が 500 ms に設定されています。こ
のストリームの反復率（525 ms）が
この値を超えているため、エラーと
してレポートされています。ただし、
Edit Parameters ダイアログ・ボックス
に表示されている最大および最小
の反復レートを調べると（マウス・ポ
インタを値フィールド上に置き、ツー
ル・チップを参照する）、525 ms とい
うレートが、DVB 規格で推奨されて
いる範囲（40 ms ～ 25000 ms）内に
あることが分かります。
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PES Analyzer の使用

各エレメンタリ・ストリーム（ビデオ、オーディオ、および補助データを含む）は、パケット化エレメンタリ・ストリーム
（PES）としてまとめられます。ここで特に注目すべき点は、トランスポート・ストリーム内の各 PES パケットに関連
付けられているヘッダです。このヘッダには、含まれているエレメンタリ・ストリームに対応するデコード・タイムス
タンプとプレゼンテーション・タイムスタンプ（DTS と PTS）が含まれています。これらのタイムスタンプにエラーが
あると、極端な場合には受信側でリセットまたはピクチャの静止といった問題が発生します。

1. PES Analyzer を開くには、Start >
All Program > Tektronix MTS4000
> Analyzers > PES Analyzer の順に
選択します。

2. File > Open を選択します。トランス
ポート・ストリームを探して、開きま
す。たとえば、「Multiplexer の使用」
で作成した TestMux.mpg ファイル
を使用します。

解析の進行状況が、ステータス・
バーとイベント・ログに表示され
ます。解析が完了すると Program
Structure ビューが表示されます。
この例では、ストリームで 1 つのプ
ログラムを伝送し、そのプログラムに
は 1 つのビデオ・エレメンタリ・スト
リームと 1 つのオーディオ・エレメン
タリ・ストリームが、それぞれ PID 33
と 34 として含まれていることが分か
ります。
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3. Program Structure ビューでビデオ・
ストリームを選択します。虫めがね
アイコンは、そのストリームが選択さ
れていることを示します。

4. View メニューで各ビュー・オプション
（つまり、Event Log、Hex、Interpre-
tation、および PTS/DTS Timing）を
開きます。それぞれのアクションに
より、PES Analyzer ウィンドウに新し
いビューが開きます。ウィンドウ内に
ビューをタイル表示するには、Win-
dow > Tile オプションを使用します。

ステータス・バーの上にあるスライ
ダ・バーを使用すると、PES ストリー
ム内の任意のパケットに移動できま
す。パケットには、ファイル内のそれ
ぞれに位置に応じて、PID 内に番
号が付けられています。スライダ・
バーには、現在のパケットのパケッ
ト番号と PID が表示されます。

Packet Hex View：

このビューでは、PES に含まれる各バ
イトを調べることができます。

左の列の 4 桁の数値は、その行の
最初のバイトのアドレスです。

マゼンタで表示されているバイトは、
PES パケット・ヘッダであることを示
しています。このヘッダは、Packet
Interpretation ビューにグラフィック
形式で表示することができます。
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Packet Interpretation View：

このウィンドウでは、現在選択されている
パケットのヘッダを解釈してグラフィック
形式で表示します。ヘッダのサイズは、
パケットの内容によって異なります。

PTS/DTS View：

このビューには、選択したストリームの
タイミング解析が表示されます。X 軸に
はストリームの継続期間が秒単位で表
示されます。Y 軸には DTS の予想値
と実際値の差が表示されます。垂直の
青い線は、アクセス・ユニットごとの PTS
と DTS の差を表します。その他のアク
セス・ユニットについての情報は、サイ
ド・パネルに表示されます。

準拠しているストリームの場合は、0 ms
の Y軸上に各DTS が表示されます。エ
ラーがあるストリームの場合は、通常、
階段状に表示されます。

グラフを拡大縮小するには、ツール・
バーの虫めがねを選択し、ビューをク
リックします。このウィンドウの下部にあ
るスライダは、表示されているパケット
の、ファイルの残りの部分との相対的な
位置関係を示します。
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T-STD Buffer Analyzer の使用

T-STD Buffer Analyzer は、仮想的なトランスポート・ストリーム・システム・ターゲット・デコーダでのバッファの動
作を、ISO/IEC 13818-1 の仕様に合わせてモデリングします。ビデオ、オーディオ、およびシステム制御の各スト
リームを処理することができます。解析結果は、時間に沿ったバッファ容量のグラフ、および例外と注目すべきイ
ベントのログとして表示されます。バッファ・モデルに適合していないと、フレームが静止したり受信側のリセット
が発生することがあります。

1. T-STD Buffer Analyzer を開くに
は、Start > Program > Tektronix
MTS4000 > Analyzers > Buffer An-
alyzer の順に選択します。

2. 設定内容を確認するには、View >
Settings を選択します。

Settings ダイアログ・ボックスの Sys-
tem タブで、MPEG2 Packet Inter-
pretation を選択し、Pre-Scan Pack-
ets で All Packets を選択します。
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3. Video タブで、Buffer Sizes の Au-
tomatic と、Data Transfer の Auto-
matic を選択します。

4. Audio タブで、Buffer Size の Auto-
matic を選択します。

5. Settings ダイアログ・ボックスを閉じ
ます。
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6. 解析するファイルを選択するには、
File > New の順に選択します。

7. MPEG ファイルを探して、開きます。
たとえば、「Multiplexer の使用」で
作成した TestMux.mpg ファイルを
使用します。

開くとすぐに、別のファイル選択ダ
イアログ・ボックスが開きます。この
ダイアログ・ボックスでは、バッファ・
モデル結果（BMR）ファイルに名前
を付けて開きます。このファイルに
は、これ以降の解析結果が保存さ
れます。

デフォルトの名前を受け入れ、ファ
イルを開きます。

プログラムにより初期解析が実行さ
れ、ストリーム・リストの作成と平均ト
ランスポート・レートの計算が行われ
ます。ストリーム・リストには、ファイ
ル内のプログラムとエレメンタリ・スト
リームがすべて表示されます。この
セッションではリスト内のすべてのス
トリームに対してまだ解析が行われ
ていないため、すべてのストリーム
に Unprocessed という表記がつきま
す。

8. トランスポート・ストリームのコンテキ
スト・メニューから Process Streams
を選択して、ストリームの処理を開
始します。

解析の進捗がステータス・バーに表
示されます。

50 MTS4000 型および MTS4SA 型クイック・スタート・ユーザ・マニュアル



手順

9. PID 33 をハイライトし、コンテキスト・
メニューから All Buffers を選択しま
す。

1 つのビデオ・エレメンタリ・ストリー
ムに関して、PID Event Log、Video
Transport Buffer、Video Multiplex
Buffer 、および Video Elementary
Buffer の各ウィンドウが表示されま
す。（Stream List ウィンドウは最小
化されています。）

10.結果ウィンドウを並べて表示するに
は、Window > Tile を選択します。

PID イベント・ログ：

次の 2 つのイベント・ログ、初期解析中
に発生する高レベル・イベントを表示
するグローバル・イベント・ログ（View >
Global Event Log）と、処理された PID
ごとのイベントを表示する PID イベント・
ログ（View > PID Event Log）を開くこと
ができます。

以下で説明するバッファ・グラフ・ビュー
には、次の機能があります。

ツール・バーの虫めがねアイコンを
使用して、選択したグラフを拡大縮
小できます。倍率値は、Reset Zoom
ツール・バー・ボタンでリセットでき
ます。

開いているすべてのグラフを、個別
に表示したり操作することがきます。
現在選択されているビューとすべて
のビューを同期させるには、Options
> Synchronize Views を使用します。

赤色の Y軸の線は、0% および 100%
の限界を示しています。

マルチプレクス・バッファ／メイン・バッ
ファ：

このビューには、ビデオ・ストリームに対
するマルチプレクス・バッファのモデリ
ング結果が表示されます。オーディオ・
ストリームおよびシステム制御ストリーム
に対しては、メイン・バッファの結果が
表示されます。タイトル・バーにはスト
リーム・タイプが表示されます。
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ビデオ・トランスポート・バッファ：

このビューには、ビデオ・ストリームに対
するマルチプレクス・バッファのモデリ
ング結果が表示されます。

ビデオ・エレメンタリ・バッファ：

このビューには、該当するビデオ・エ
レメンタリ・ストリームのみが表示されま
す。

11.View > Trace を選択して、トレース・
ログを表示します。

トレース・ログを使用すると、Buffer
Analyzer により作成されたメッセー
ジ・ログを解析できます。これらのロ
グは、内部処理、特にビデオ・スト
リーム・タイプを詳細に解析するの
に役立ちます。トレース・ビューに
は、関心のある特定のメッセージ・
タイプに絞り込むためのフィルタリン
グ機能が備わっています。
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Elementary Stream Analyzer の使用
ES Analyzer は、CODEC の MPEG-2 規格および H.263 規格への適合を調べます。MPEG-2 オーディオ
（ISO/IEC 13818 Part 3 および 7）、AC-3、および MPEG-4 AAC のオーディオ・デコードと波形表示もサ
ポートされています。

ES Analyzer は、ビデオ・ストリームおよびオーディオ・ストリームのさまざまな側面の解析に使用できる複合アプリ
ケーションです。このため、以下の手順では一部の解析画面へのアクセス方法を示しています。各画面の内容と
その意味の詳細については、『MTS4000 アナライザ・アプリケーション・ユーザ・マニュアル』を参照してください。

1. ES Analyzer を開くには、Start >
All Program > Tektronix MTS4000
> Analyzers > ES Analyzer の順に
選択します。

2. 解析するファイルをFile > Open で
選択します。

MPEG ファイルを探して、開きます。
たとえば、「Multiplexer の使用」で
作成した TestMux.mpg ファイルを
使用します。

3. ナビゲーション・ウィンドウの各ノー
ドを順にクリックして、Program 1 /
PES (PID 33)、MPEG 2 Video ブラ
ンチの GOP（Group of Pictures）を
ハイライトします。
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4. Picture Player タブを選択します。
ピクチャ・プレーヤのリモート・コント
ロールが表示されます。

5. Show Information ボタンをクリックす
ると、コントロール・バーが拡大しま
す。追加情報として、表示されてい
るピクチャのファイル内の位置が示
されます。ステータス・バーには詳
細情報が表示されます。

6. コントロール・バーの再生ボタンをク
リックして、ストリームの再生を開始
します。

再生を停止すれば、他の GOP タブ
（GOP And Picture、Slice And MB）
を選択して、そのフレームの特性を
調べることができます。

7. たとえば、Slice And MB タブで
Picture Display を選択します。この
ピクチャは、ピクチャ・プレーヤのピ
クチャに対応します。

8. Picture Display の右側にある Show
MV をクリックします。B および P フ
レームでは、モーション・ベクトルは、
ピクチャに重なって表示される色付
き矢印として表示されます。
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さらに、マウスをピクチャのマクロブ
ロック上に置くと、ピクチャを構成し
ているマクロブロックの特性を表示
できます。

9. Previous Frame ボタンおよび Next
Frame ボタンを使用すると、ストリー
ム内を前後に移動して、モーション・
ベクトルを比較できます。

同様の方法で、オーディオ・ストリー
ムの特性も調べることができます。

10.ナビゲーション・ウィンドウの各ノー
ドを順にクリックして、Program 1 /
PES (PID 34)、MPEG 1 Audio ブラ
ンチの GOP（Group of Pictures）を
ハイライトします。

オーディオ・コントロール・バーを使
用すると、オーディオ・トラックを確
認できます。出力を聴取するには、
ヘッドフォンを使用する必要があり
ます。
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TSCA FlexVuPlus™ ディスプレイ

Transport Stream Compliance Analyzer で、FlexVuPlus を使用すると、解析詳細ビューから最大 4 つビューを選
んで一緒に表示し、基本的なトランスポート・ストリームのモニタや詳細な診断モニタを容易に行うことができます。

ここでは、説明の便宜上、現在表示さ
れているすべての FlexVuPlus パネル
をいったん閉じるものとします（各パネ
ル右上隅の X をクリックします）。

これは必須ではありませんが、こうして
おけば、各パネルを配置する手順が
理解しやすくなります。これ以降は、
FlexVuPlus の各パネルを番号順に説
明します。

パネル 1 のセットアップ

1. Analysis タブをクリックし、次に Tests
タブをクリックします。

すべての詳細ビューの右上隅に
FlexVuPlus のパネル選択ボタンが
あります。このボタンを使用して、
選択した FlexVuPlus パネルに詳細
ビューの複製を表示できます。

2. Test Summary ビューで FlexVuPlus
パネル選択ボタンを使用して、この
ビューをパネル 1 に複製します。
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3. これで、FlexVuPlus のパネル 1 に
テスト・サマリ・ビューが表示されま
す。

パネル 2 のセットアップ

4. Analysis タブをクリックし、次に Pro-
grams タブをクリックします。

5. Thumbnails ビューで FlexVuPlus パ
ネル選択ボタンを使用して、この
ビューをパネル 2 に複製します。
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6. これで、FlexVuPlus のパネル 2 に
サムネイル・ビューが表示されます。

パネル 3 のセットアップ

7. Analysis タブをクリックし、次に Tests
タブをクリックします。

8. Test Failures ビューで FlexVuPlus
パネル選択ボタンを使用して、この
ビューをパネル 3 に複製します。
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9. これで、FlexVuPlus のパネル 3 に
テスト・エラー・ビューが表示されま
す。

この例では 3 つのパネルしか使用
していないので、サムネイル・ビュー
を拡大し、FlexVuPlus™ の右側全体
に表示できます。

パネルの垂直方向拡大ボタンを選
択して、パネル 2 を縦方向に拡大
できます。

（同様に、パネルを横方向に拡大
するには、パネルの水平方向拡大
ボタンをクリックします）。

10. パネル 2 を拡大して、総合的
な FlexVuPlus の基本的なモニタ・
ビューのできあがりです。
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このビューでは次の項目をすぐに確認できます。

テスト・サマリ・ビュー（FlexVuPlus パネル 1）- 失敗したテスト

テスト・エラー・ビュー（FlexVuPlus パネル 3）- 直近に失敗したテスト

サムネイル・ビュー（FlexVuPlus パネル 2）- ビデオ・コンテンツを配信中のエレメンタリ・ストリーム

複数入力のモニタ
MTS4000 システムは、Transport Stream Compliance Analyzer の複数のインスタンスを使用して、（別個の 10
G または PC の NIC ポート上の）複数のトランスポート・ストリームをモニタすることが可能です。

1. Transport Stream Compliance Ana-
lyzer を開くには、File > Program >
Tektronix MTS4000 > Analyzers >
TS Compliance Analyzer の順に選
択します。

TSCA Analysis ツールバーの Real-
time Analysis... を選択します。

2. Select Real-time Interface ダイアロ
グ画面で、Interfaces プルダウン・メ
ニューから使用可能な入力を選択
します。

この例では、TS Compliance Analyzer
アプリケーションのこのインスタンスによ
るモニタに、ASI-3 入力が選択されて
います。

選択肢は、使用できるオプション入力
によって異なります。
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3. Transport Stream Compliance Ana-
lyzer のインスタンスをもう 1 つ開
きます。File > Program > Tektronix
MTS4000 > Analyzers > TS Compli-
ance Analyzer の順に選択します。

TSCA Analysis ツールバーの Real-
time Analysis... を選択します。

4. Select Real-time Interface ダイアロ
グ画面で、Interfaces プルダウン・メ
ニューから使用可能な入力を選択
します。

TS Compliance Analyzer のこのインスタ
ンスでは、ASI-4 入力をモニタするよう
に選択されています。
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アクセサリ

スタンダード・アクセサリ
次の表は、MTS4000 型機器に付属するスタンダード・アクセサリを示しています。

説明 部品番号 MTS4000 MTS4SA

適合性証明書 001-
1180-XX

■ ■

ソフトウェア CD-ROM：MTS4000 アプリケーション・ソフトウェ
ア・メディア

063-
4385-XX

■ ■

Certificate Of Authenticity：Microsoft Windows 7 NA ■

ソフトウェア DVD：MTS4000 オペレーティング・システムのリス
トア DVD

063-
4387-XX

■

MTS4000 型製品マニュアル CD-ROM

CD には、MTS4000 型とそのソフトウェア・アプリケーションをサ
ポートするすべてのマニュアルが含まれています。

063-
4386-XX

■ ■

MTS4000 型および MTS4SA 型クイック・スタート・ユーザ・マ
ニュアル

071-
2970-XX

■ ■

補足情報シート、中国 RoHS 071-
2185-XX

■ ■

ハードウェア・キー（ドングル）、USB NA ■ ■

電源コード（以下のいずれか）

北米（オプション A0）

汎用欧州（オプション A1）

英国（オプション A2）

オーストラリア（オプション A3）

北米 240 V（オプション A4）

スイス（オプション A5）

日本（オプション A6）

中国（オプション A10）

インド（オプション A11）

電源コードおよび AC アダプタなし（オプション A99）

NA ■
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オプションとアップグレード

オプション

次の表は、MTS4000 型で注文可能なソフトウェアおよびハードウェアのオプションを示しています。オプショ
ンに含まれるアクセサリも記載されています。

オプション 説明

ハードウェア・オプション

ASI マルチポート ASI インタフェース。

最大 4 つの出力ポート。ポート 1 とポート 2 は RF カードおよび IP カード用に予
約されています。ポート 3 とポート 4 が使用可能です。

S2 QPSK、8PSK、16APSK、および 32APSK の復調をサポートする DVB-S/S2 インタ
フェース（オプション ASI 型が必要）。

75 Ω BNC - BNC ケーブル（当社部品番号 174-5135-xx）が含まれます。

VS 8VSB インタフェース（オプション ASI 型が必要）。

75 Ω BNC - BNC ケーブル（当社部品番号 174-5135-xx）が含まれます。

QB2 QAM B インタフェース（オプション ASI 型が必要）。

75 Ω BNC - BNC ケーブル（当社部品番号 174-5135-xx）が含まれます。

IPTV 10／100／1000 Base-T RJ45 電気ポートの IPTV Gb イーサネット・インタフェース
（オプション ASI 型が必要）。

75 Ω BNC - BNC ケーブル（当社部品番号 174-5135-xx）が含まれます。

SX 1000 Base-SX 短波長 SFP 光ポート、IPTV イーサネット・インタフェース用 LC コ
ネクタ付き（マルチモード 850 nm）。

LX 1000 Base-LX 長波長 SFP 光ポート、IPTV イーサネット・インタフェース用 LC コ
ネクタ付き（シングルモード 1310 nm）。

ZX 1000 Base-ZX SFP 光ポート、IPTV イーサネット・インタフェース用 LC コネクタ付
き（シングル・モード 1550 nm）。

10GS 10GBase-SR デュアル・オプティカル・ポートの 10 Gbps NIC。短距離用 SFP+ モ
ジュール（850 nm）を含む。

ソフトウェア・オプション

GEN Multiplexer、MPEG Player、Transport Stream Editor、Make Seamless Wizard、
Transport Stream Cutter、および Script Pad。

Tclips MPEG テスト・ストリーム・ソフトウェア・メディアを含みます。

ESS 標準 ES 解析。全オプション付属の MTS4CC + MPEG-2 ESAnalyzer を含みます。

ESE 拡張 ES 解析。全オプション付属の MTS4EAB + MPEG-2 ES Analyzer を含みま
す。

VQ ビデオ・クオリティ・ソフトウェア、シングル・エンド。全オプション付属の VQS1000
を含みます。

PQ ピクチャ品質解析ソフトウェア、シングル・エンドおよびダブル・エンド。オプション
IP 型付属の PQASW を含みます。

PB PES Analyzer および T-STD Buffer Analyzer。
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オプション 説明

パッケージ・オプション

430 内容：Player、Multiplexer、および Tclips テスト・ストリーム、PES Analyzer および
Buffer Analyzer、全オプション付属の MTS4EAB、MPEG-2 ES Analyzer。

アップグレード・キット

MTS4000 型テスト・システムの購入後に機器の機能を拡張できるように、アップグレード・キットが用意されて
います。キットは、ソフトウェア、ハードウェア、またはその両方を含む場合があります。

機器へのハードウェアの取り付けは認定技術者が行います。

オプション 説明

MTS4KUP

GEN Multiplexer、MPEG Player、Transport Stream Editor、Make Seamless Wizard、
Transport Stream Cutter、および Script Pad。

Tclips テスト・ストリームのメディアを含みます。

ESS 標準 ES 解析。全オプション付属の MTS4CC + MPEG-2 ESAnalyzer を含みます。

ESE 拡張 ES 解析。全オプション付属の MTS4EAB + MPEG-2 ES Analyzer を含みま
す。

VQ ビデオ・クオリティ・ソフトウェア、シングル・エンド。全オプション付属の VQS1000
を含みます。

PQ ピクチャ品質解析ソフトウェア、シングル・エンドおよびダブル・エンド。オプション
IP 型付属の PQASW を含みます。

PB PES Analyzer および T-STD Buffer Analyzer。

ASI マルチポート ASI インタフェース（4 ポート）。

S2 QPSK、8PSK、16APSK、および 32APSK の復調をサポートする DVB-S/S2 インタ
フェース。

VS 8VSB インタフェース。

QB2 QAM B インタフェース。

IPTV IPTV Gigabit イーサネット・インタフェース（10/100/1000 Base-T R-J45 電気ポー
ト）。

10GS 10GBase-SR デュアル・オプティカル・ポートの 10 Gbps NIC。短距離用 SFP+ モ
ジュール（850 nm）を含む。

SX IPTV イーサネット・インタフェース用の LC コネクタ（マルチ・モード 850 nm）付き
1000BASE-SX 短波長光ポート。

LX IPTV イーサネット・インタフェース用の LC コネクタ（シングル・モード 1310 NM）付
き 1000BASE-LX 長波長光ポート。

ZX IPTV イーサネット・インタフェース用の LC コネクタ（シングル・モード 1550 nm）付
き 1000BASE-ZX 光ポート。
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MTS4000 型のシステム・リカバリ

MTS4000 システム・ソフトウェアに問題が生じた場合は、このセクションの手順に従って、システムを出荷時
のデフォルトのインストレーションと設定に戻します。

完全なシステム・リカバリを行うには、Windows オペレーティング・・システムのリストアと MTS4000 型 MPEG
テスト･システムの再インストールが必要です。

システム・リカバリは 1 台目のハード・ディスク（C:）に影響しますが、2 台目のハード・ディスク（D:）には影
響を与えません。

注： 交換用ディスクとして当社にご注文のハード・ディスク・ドライブに交換した後でソフトウェアをリストアす
る場合は、ハード・ドライブ交換キットに付属の指示書に従ってください。

オペレーティング・システムのリストア
機器のオペレーティング・システムのリストアは、機器のハード・ディスク・ドライブ上のファイルか、またはそ
の機器のリストア DVD から行います。推奨されるリストア方法は、ハード・ディスクのリストア・ファイルを使用
することです。

注意： データを失わないように、ハード・ディスクに保存した重要なユーザ・ファイルはすべてバックアップし
てください。このオペレーティング・システムのリストア手順は、1 台目のハード・ディスク（C:）を再フォーマッ
トします。これによりユーザがインストールしたファイルやアプリケーションはすべて消去されます。2 台目の
ハード・ディスク（D:）には影響しません。

Windows が起動しない場合は、前回正常起動時の構成を使用して起動できる場合があります。

問題を避けるために、機器で使用する Windows は、Tektronix から特別に提供されているバージョン以外の
Windows と置き換えないようにしてください。Windows のバージョンは、本機器用に特別に構成されていま
す。他のバージョンの Windows では適切に動作しません。

機器のハード・ディスクからオペレーティング・システムをリストアする

本機器では、ハード・ドライブの別のパーティションにオペレーティング・システム・リストア用ファイルが含ま
れています。

1. 機器を再起動します。起動プロセスが実行されている間、画面の上部に次のメッセージが表示されます。

Starting Acronis Loader... press F5 for Acronis Startup Recovery Manager

2. Acronis True Image Tool が開くまで、F5 キーを繰り返し押します。メッセージが表示されてから機器が通
常どおり起動するまでに 5 秒かかります。Acronis アプリケーションが起動しない場合は、機器の電源を
切ってから、もう一度電源を入れてみます。

3. Recover をクリックします。

4. Confirmation ダイアログ・ボックスで、Yes をクリックして機器のオペレーティング・システムをリストアしま
す。リストアせずにプロセスを終了するには、No をクリックします。リストア・プロセスには約 30 分ほどを要
しますが、実際にかかる時間は機器の設定によって異なります。

5. メッセージが表示されたら、機器のシャットダウンか再起動を行います。

6. MTS4000 システム・アプリケーションをインストールします。
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OS リストア DVD を使用してオペレーティング・システムをリストアする

機器のシステム・ソフトウェアをリストアするには、MTS4000 型機器に付属する MTS4000 型 MPEG テスト・シ
ステム・オペレーティング・システム・リストア DVD（063-4387-XX）が必要です。

1. オペレーティング・システム・リカバリメディアのディスク 1 を機器の DVD ドライブに挿入し、ドライブのド
アを閉じます。

2. 機器を再起動します。

機器が DVD から再起動しない場合は、次のようにして再起動します。

ブート・プロセスで、ブート・ドライブのメニューが表示されるまで、F11 ファンクション・キーを繰り返し
押します。

CD/DVD をブート・デバイスとして選択し、Enter キーを押します。これで機器が DVD からブートしま
す。

注： 必要な場合、キーボードの矢印キーを使用して、必要なリストア・オプションを選択します。

3. メッセージが表示されたら、Recover the original system installation を選択し、Enter キーを押します。

4. Enter キーを押してインストールを続けます。リストア・プロセスが始まります。

注： このプロセスには時間がかかります。ファイルをコピーする最初の 10 分間、進捗バーは進みません。

注： 表示される指示に従ってください。この手順の中でディスクの交換が必要となります。

DVD を挿入するたびに、DVD の作動インジケータの点滅が終わるまで待ってから、OK または Retry を押
してください。点滅が終わるまで待たないと、インストールを一時中断するためのポップアップが表示されま
す。その場合は OK を選択します。

5. Acronis のリストア・プロセスが完了したら、リストア・ディスクを取り出します。

6. メッセージが表示されたら、再起動かシャットダウンを選択して OS のリストア・プロセスを終了します。機
器が再起動するか、その電源が切れます。

7. Windows のメッセージが表示されたら、Restart Now を選択して機器を再起動すると、すべてのデバイス・
ドライバのインストールが完了します。

8. MTS4000 システム・アプリケーションをインストールします。
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MTS4000 システム・アプリケーションのインストール
MTS4000 システム・アプリケーションのインストール手順は、スタンドアロンのインストール手順と同様です。

MTS4000 型プラットフォームに MTS4000 アプリケーションをインストールするには、インストール手順で Install
on MTS4000 Platform（MTS4000 型プラットフォームへのインストール）を選択して、インストールを続けます。

MTS4000 アプリケーションのインストール後に、ソフトウェア・ライセンス・キーを回復する必要があります。こ
のことは、スタンドアロンのインストール手順に説明されています (5 ページ 「MTS4SA 型スタンドアロン・シ
ステムのインストール」 参照)。
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ユーザ・メンテナンス

このセクションでは、MPEG テスト・システムの一般的な注意事項と保守の手順について説明します。

「予防保全」には、クリーニングの手順について説明します。

「問題が発生した場合」には、起動エラーのトラブルシューティングのヒントをいくつか示します。

「輸送用の再梱包」には、機器を梱包して輸送するための手順を示します。

一般的な注意事項
機器は、厳しい気候条件から保護する必要があります。この機器は防水加工されていません。

注意： スプレーや液体、溶剤に接触させないでください。機器が破損する可能性があります。

化学薬品の洗浄剤を使用しないでください。機器を損傷する恐れがあります。ベンゼン、トルエン、キシレ
ン、アセトンまたはこれに類似する溶剤を含有する化学薬品を使用しないでください。

予防保全
年に一度、電気的な性能をチェックし、機器の確度を検証（校正）する必要があります。

予防保全は、主に定期的なクリーニングによって実現されます。定期的にクリーニングすることにより、機器が
故障しにくくなり、信頼性が高まります。動作環境に基づき、必要に応じて機器をクリーニングする必要があり
ます。コンピュータ室のような条件に比べると、汚れた条件下ではより頻繁にクリーニングする必要があります。

外部のクリーニング

機器の外部表面のクリーニングには、乾いた柔らかい布か柔らかい毛ブラシを使用してください。汚れが落
ちない場合は、75% のイソプロピル・アルコール溶剤を染み込ませた布または綿棒を使用してください。コン
トロールやコネクタ周囲の狭い箇所のクリーニングには綿棒が役立ちます。機器のどの部分にも研磨剤は
使用しないでください。

注意： 外部のクリーニング時に機器の内部を濡らさないように、布または綿棒が湿る程度の量の溶剤のみを
使用してください。洗浄剤として 75% のイソプロピル・アルコール溶剤を使用し、純水で洗い流してください。

フロント・パネルのオン／スタンバイ・スイッチは水拭きしないでください。機器のクリーニング中はスイッチを
覆ってください。

キーボードのクリーニング

キーボードおよび内蔵トラッキング・デバイスの外部表面のクリーニングには、乾いた柔らかい布か柔らかい
毛ブラシを使用してください。コントロールやコネクタ周囲の狭い箇所のクリーニングには綿棒が役立ちま
す。機器のどの部分にも研磨剤は使用しないでください。
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注意： 外部のクリーニング時にキーボードや内蔵トラッキング・デバイスの内部が湿らないように、布または
綿棒が湿る程度の量の溶剤のみを使用してください。洗浄剤として 75% のイソプロピル・アルコール溶剤を
使用し、純水で洗い流してください。

問題が発生した場合
このセクションでは、テスト・システムの使用中に発生する可能性がある問題について説明します。このセク
ションでは、性能の検査や調整に関連した具体的な問題は取り上げていません。このセクションで説明する
MTS4000 システムの診断手順は、問題の切り分けに役立ちます。性能検査の手順については、『MTS4000
型製品マニュアル』CD-ROM に収録の『MTS4000 型仕様および性能検査テクニカル・リファレンス』（PDF
ファイル）を参照してください。

起動時のセルフテストは、テスト・システムのアプリケーションを起動するために機器の電源を最初にオンに
したときに実行されます。これらの診断では、オペレーティング・システムとハードウェアが正しく動作すること
がチェックされます。起動時のセルフテストでエラー・メッセージが発生した場合は、MTS4000 システム・ソフ
トウェアの起動を妨げるシステム・エラーが存在する可能性があります。

以下の表は、オペレーティング・システムと周辺機器に関連するハードウェアの問題の症状と、考えられる解決
策のいくつかを示しています。

症状 考えられる原因と推奨される対応

機器の電源が入らない 電源コードが機器と電源に接続されていることを確認します。

オン／スタンバイ・スイッチを押したときに機器に電気が供給され
ること、およびファンが回転することをチェックします。

電源から電力が供給されていることを確認します。

当社サービス受付センターにお問い合わせください。

機器の電源が入っても、起動時シーケ
ンスが完了しない

機器がハード・ディスク・ドライブから起動していることを確認しま
す。

起動時のセルフテストが失敗する 当社サービス受付センターにお問い合わせください。

機器が、外部のモニタ、プリンタ、キー
ボードなどのアクセサリを認識しない

アクセサリが適切に接続され、インストールされていることを確認
します。

当社サービス受付センターにお問い合わせください。

オン／スタンバイ・スイッチで機器の電
源が切れない

Windows 7 のシャットダウン手順に従って機器の電源をオフにし
てみてください。それでも機器の電源が切れない場合は、タスク・
マネージャを使用してタスクを終了します。最後に、強制シャット
ダウン手順を試してください。オン／スタンバイ・スイッチを 5 秒
間押したままにして、機器の電源を切ります。

ソフトウェアに関する問題

MPEG テスト・システムはソフトウェアがインストールされた状態で納品されます。ソフトウェアに問題があると
思われる場合は、テスト・システムのアプリケーション・ソフトウェアの問題と、インストールされている他のソフ
トウェアの問題を区別するようにしてください。
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ソフトウェアに関する問題の多くは、ソフトウェア・ファイルの破損または不足が原因になっています。ほとん
どの場合、ソフトウェアに関する問題を解決するための最も簡単な方法は、ソフトウェアを再インストールする
ことです (65 ページ 「MTS4000 型のシステム・リカバリ」 参照)。

ネットワークに問題があると思われる場合は、「ネットワークのトラブルシューティング」を参照してください
(14 ページ 「ネットワークのトラブルシューティング」 参照)。

ハードウェアに関する問題

ハードウェアの問題にはいくつかの原因が考えられます。このマニュアルの設置手順を読みなおして、機器
を正しく設置していることを確認してください。MTS4000 システムにはユーザが保守できる部品はないため、
ハードウェアの問題が生じた場合は、当社サービス受付センターにお問い合わせください。

TS Compliance Analyser P1 アイコンのリストア

うっかり TS Compliance Analyser P1 アイコンをデスクトップから削除してしまった場合は、次の手順でアイコ
ンをリストアすることができます。

1. TS Compliance Analyser アイコンをデスクトップかスタート・メニューからコピーします。

2. アイコンを選択し、右クリックして Properties を選択します。

3. Shortcut タブを選択します。

4. Target フィールドでリンク先文字列の末尾に /p1 を追加します。
リンク先文字列は次のようになります。
"C:\Program Files (x86)\Tektronix\mpeg\MTS4000\Apps\TSCA\bin\TSCA.exe" /p1

注： “ と /p1 の間には空白が必要です。

5. ショートカット・アイコンの名前の末尾に P1 を追加して名前を変えます。
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修理のための機器の返送
機器を輸送用に再梱包する場合は、元の梱包材を使用してください。元の梱包材が手元にないか、使用に
適していない場合は、当社営業所まで新しい梱包材を依頼してください。

1. 輸送用カートンを業務用ステープルまたは丈夫なテープで止めます。修理のために機器を返送する前
に、サービス受付センターに連絡して RMA（Return Material Authorization）番号を入手し、また詳細に
ついてお問い合わせください。

2. 機器を当社サービス受付センターに送る際には、次の情報を添えてください。

RMA 番号

住所

担当者の名前と電話番号

機器のシリアル番号

返却の理由

ご依頼の詳細な説明

3. 梱包箱の見やすい 2 箇所に、当社サービス受付センターの住所と返却先住所を記してください。
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